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BlueTile
(STEVAL-BCN002V1)

- Training Material Check/Installation Help

 ARM® Keil MDK Installation

* Introduction to Bluetooth® Low Energy

* BlueTile Development Kit

- ARM® Keil MDK License Installation

- Lab 1: Getting Started with BlueTile “Serial Terminal Test”
 Lab 2: Connecting to the ST BLE Sensor app

 Lab 3: LED characteristic

 Lab 4: Accelerometer embedded events detection

- Lab 5: 9-axis Acc+Gyro+Mag Sensor Data Fusion

* Lab 6: Cloud data logging on IBM Watson

- Lab 7: Bonus — Voice over BLE

Agenda

WiFi Network: STMicro
Password: STMTT19
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On St.com

http://www.st.com/bluetile
‘,—I-..augmemgd Products ~ | Search.., ContactUs  English v

Products [ Applications ¥ Tools & Software sample & Bu Support & Community & Login

Evaluation Tools > Solution Evaluation Toals > Sensor Sclution Eval Boards > STEVAL-BCNOO2ViB >

STEVAL-BCNOO2V1B ; = Frint ‘ Save la MyST Share via Email

This product is in stock in our
BlueTile - Bluetooth LE enabled sensor node development kit e-store

Dewnload databrief

Qverview Tools & Software Resources Quality & Reliability

The STEVAL-BCN002V1B Bluetooth LE enabled sensor node development kit features the STEVAL-
BCNO02V1 multi-sensor board based on BlueNRG-2 SoC Bluetooth Low Energy application processor.
This sensor board has accelerometer, gyroscope, magnetometer, pressure, humidity, Time-of-Flight and

‘,’ microphone sensors, and is powered by a common CR2032 coin battery.

life.augmented The sensor board communicates with a Biuetooth LE



Software
Development
Kit
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BlueTile SDK mem

hitp://www.st.com/bluetile

Products
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Products ” Applications P Tools & Software

Search

ContactUs  English ~

Support & Community 1 Login

Evaluaiion Teols > Selufion Evaluation Tools > Sensor Solution Eval Boards > STEVAL-BCNODZVIE >

STEVAL-BCNO02V1B

BlueTile - Bluetooth LE enabled sensor node development kit

S| Download databrief

Tools & Software

Overview

Quick links

Ewvaluation Too! SoRware Wireless

Embedded Software

EVALUATION TOOL SOFTWARE

WIRELESS CONNECTIVITY SOFTWARE

= Pint M SavetoMyST Share via Email

This product is in stock in our
e-slore

7 sampleand buy

Resources Quality & Reliability

ronneclivity Software



BlueTile SDK mm

* https://www.st.com/en/embedded-software/stsw-bluetile-dk.nhtml

Lys
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STSW-BLUETILE-DK

= Prnt M saveto MyST Share via Email

(=]

Software development kit for the BlueTile, including sensor data streaming over BLE, HID peripheral, Beacon, efc

Get Software Download databrief

Overview Tools & Software Resources

The STSW-BLUETILE-DK is based on STSW-BLUENRG1-DK evaluation SW package.

BlusNRGC-2 Paripherals

‘ MPMDTOSA | LSMGsQ |  HTsz2t ||
e W*J VLSILIX | LiszwDL LPSZaHH |

- STEVAL-ECNOOZVIE
Development Boards |81 G-2 e kit

The STSW-BLUENRG1-DK package supports the
BlueNRG-1 and BlueNRG-2 Bluetocth Low-Energy
system-on-chip. This package includes a Wizard PC
application to automatically generate the configuration
header file needed for the BLE radio Initialization. This
package also includes BlueNRG-1 and BlueNRG-2
peripheral drivers and related examples, the BLE
firmware stack together with the HAL (Hardware
Abstraction Layer) and CryptoLib (Cryptographic
Library).

The STSW-BLUETILE-DK supports the BlueTile

nlatfarm Thic narkana aviands QTSN R | IDNBE1 MW



On St.com
hitp://www.st.com/bluetile

Contact Us English v
= augmented

222 Products P Applications  § Tools & Software ¢ 58 > Support & Community X Login

Evaluation Tools > Soiufion Evaluaiion Tools > Sensor Solufion Eval Boards > STEVAL-BCNOOD2V1B >

SChematic STEVAL-BCNOO2V1B & rrint Q) savetomysT [l Share via Emai
Gerbers
BOM

This product is in stock in our
e-slare

[ Download databrief =7 Sample and buy

Overview Tools & Software Resources Quality & Reliability

Quick links
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Companion ST BLE Sensor App mm
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ON YOUR PHONE

- Look for “ST BLE Sensor” on the App Store or Google Play

|

#  Download on the ]

S App Store

GET ITON

Google Play

,




Where to Get |t e

Sample & Buy

7
Part Number Marketing Budgetary Quantity Core Product ECCN Country Order from Distributors Order from ST
= Status Price [USS) (uUs) of Origin
STEVAL- CTIVE b0.0 1 BlueNRG-2, BALF-NRG- gA992C ITALY B Check Availability =7 Buy direct
BCNOCE2ZVIB 6203, LSMeDS50, y

\

LIS2MDL, VL5311X,
MPI4ETOSTR-A,
LRS22HH, HTS221

Lys
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Where to Get It mmm

7 Contact Mousar (L 73| @ Feedback Change Location E us|
d MEQHEECHE Products Manufacturers Technical Resources Services & Tools Halp Order History Login Register 'E @
Alv | EBY v son Cross
All Products > Embedded Solutions » Engineering Tools > Sensor Development Tools > GSee an Emor?

Muttiple Function Sensor Development Tools > STMicroelactronics STEVAL-BCNOOZV1B

Order in the next 58:18 [o ship teday. Leam More

STEVAL-BCN002V1iB In Stock: 49
KY_I Mouser #: 511-STEVAL-BCNOO2V1B Stock: 45 Can Ship Immediately
e Mfr. #: STEVAL-BCNO0ZVB On Order: 30
View Dellvery Dates
M. STaicroelecironics
Factory Lead-Time: 11 Weeks
Customer #:
Minimum: 1 Multipies: 1
Enter Quantity:
Description: Multiple Function Sensor Development Buy
Tools BIueNRG-Tile - Blugtooth LE enabled
sensor node development kit Pricil‘lg (USD)
@ Enlarge Lifecycle: @ New Product: New frorm this a Unit Bri Ext. Pri
" manufacturer. Y " R ALLHeR
Images are for raference only . 1 - 5
See Product Spetifications Datasheet: h STEVAL-BCNOG2V1B Datasheet 000 5008
.c Share More Information: Leam more about STMicroelectionics
STEVAL-BCNOD2V1B
NEWEST PRODUCTS
Shipping Alert: [E5H] This product may require additional STMICROELECTRONICS

documeniation to export from the United
‘ ’ I States
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https://my.st.com/ols
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Producis Search

Products [ Applications ¥ Tools & Software About ST

Online Suppor

English

Welcome back!
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Enter your e-mail address and password to login your myST user.

E-mail address

Password

Remember me on this computer.

New user?

myST brings you a set of persanalized features

Participate to ST Events
> Stay informed with ST eNewsletters
> Get help with ST Online Support
> Discuss on the ST Community
> Benefit from our Online Design Tools
> Download Software
> Qrder free samples
> Manage your weekly product updates
> Buy ST Products & Tools

Create Account

Support




Online Suppor

"_’ STMicroelectronics Service Portgl New Request  J RAF RIVA G Logout
augrnanien

s

No Cases found. Click on ‘New Request’ to create one.

[’7 STMicroelectronics Service Portal  New Request R RAFRIVA  Ce¢Logout

- oorte

Case Details

N
Insert the Part Number

STEVAL-BCNO02V1B

‘ ,I Type something
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Introduction to
Bluetooth Low Energy
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Bluetooth® Evolution

« 20 Years in the market!

: Classic > & S
- 2009: Classic BLE 5 5 &8 o 2
& .o R & & & & )
F & & @ SR » &
Q ¥ &N & c &
R & X N & & YRS
7 C > v & R XS S -0
& & o B K e S Ay o2 &
o &0 & Q o\ < ™ v (o) Qo
R o SRS & -4 @*q’ & A VX
&Q,b ((\_‘_z Q‘Q’O« ’ \g@’ 'DQ- QP ?‘(J <<,Q _\)‘} \ 0&5‘5\ i (gbc" Qt\s 6"
on Q’\)QO ',S\Qv b\\o Qé 6\(}0 ,@F} \50 \,0\‘; (JO'QJ o\,}c} ’5{\0 Q,Q‘ Q \(\
v & (@ &L &8 &L > & & SN @ )
((\‘\d}‘ ‘S\’b\? ?.bﬁt;\’bq __\QF\ ,DQ(I Q\e' \’,'\-Q} Q}(J X0 (O\I \\,\"‘?o Q\\Qé\ QCC\‘ @W406'
AN Lol < ™
1.0 1.1 1.2 2.0 2.1 3.0 4.0 4.1 42 5.0
@] O O O O O O O O B
1999 2000 2003 2004 2007 2009 2010 2013 2014 2016

Bluetooth Classic
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Bluetooth Low Energy (LE)
Designed for Success

Lower power than Bluetooth “Classic” (or Bluetooth 3.0)
» Lower duty cycle

» Faster connection

* Lower peak power (relaxed RF parameters)

Compatible with all major platforms (iOS, Android, Windows, Linux)

Multiple network topologies:

» Point to point: single master connects to single slave (and each slave can connect to 2
master)

« Star: Multiple slaves connected to a single master
* Mesh: introduced in the 2017

State of the Art encryption, security including privacy/authentication

.‘KYI
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Protocol Stack

Application
B » Generic Acces Profile
* How a device can discover and connect with one another
- Generic Attribute Profile
o * How services, characteristics can be discovered and then used
— .
O - - Attribute Protocol
= I  Protocol for discovering, reading, and writing attributes on a peer
) - Security Manager
-(7) * Handles the secure communication
5|
n L  Protocol multiplexer. Segmentation and reassembly of packets
Y s | ——
o8 % * Interface between Host and Controller
= ! - Link Layer
- % Link layer » Handles packets, channels, advertising, scanning & connections
‘— - Physical Layer
, O o PHY layer * Transmits/receives bits




Protocol Stack: PHY

- ABLE Radio is a 2.4 GHz ISM Band Transceiver

* 40 RF Channels, 2 MHz Channel Spacing. Two types of channels:

- Advertising channels (3 - orange) for Advertising Packets. Used for Discoverability and
for Broadcasting/Observing

- Data Channels (37 - blue) for Data Packets. Used to send application data in Connection

- GFSK Modulation
« BT=05
* Modulation Index = 0.5

horNmsnorma SN RN e LRl AR RARRARSNR2S » “pulse shaping” Gaussian
> filter “smooths” transitions
(3] ol o - hredl a .

G7 CeISSESEESTEINSEERICRI IR 0553585 55E58 0 P
[F

life.augmented Source : Bluetooth® SIG



Protocol Stack - GAP

Application

BLE Application Profiles

_ » - Who controls the radio network?
 GAP (Generic Access Profile)
— 3 - - Broadcaster
- - « Observer
9 « Peripheral
m =
R oo convoter erce
— @ Host Controller Interface
m o
_ € Link layer
@)
‘1[ O [ PHY layer

life.augmented



I’'m looking
for John

18 Peripheral l l ! @

Peripheral is in Advertising mode.
Sends Advertising packets.

GAP
24

Central is Scanning.
Look for known peripherals by listening

to advertising packets.
My name is John

My capabilities are X, Y, Z,
etc...
1))
Advertising packets consists of multiple

')) information units known as AD types.
‘— E.g.: Local Name, TX Output Power,
> /4 Manufacturer Specific info, etc...

life.augmented

As the John peripheral is found,
it initiates a BLE connection.



BLE System

{

Controller

Host

Application

BLE Application Profiles

Host Controller Interface
Link layer

PHY layer

e

Protocol Stack - GATT

* Who controls the data flow?
 GATT (Generic Attribute Profile)

e Defines 2 roles

+ Server
e Client



Server

Server contains
the data.

Receives requests,
executes, responds. | Mg,

Data

Can indicate value Data

Protocol PDU Type

Request

Response

Command

Notification
Indication

‘,I Confirmation

life.augmented

Client
Server
Client

Server
Server
Client

GATT

Client talks to

Requests the server.
Sends requests,
wait for response.
Responses Can confirm
indications
Description

Client requests something from server (it always causes a response)

Server sends response to a request from a client
Client commands something to server (no response)
Server notifies client of new value (no confirmation)

Server indicates to client new value (it always causes a confirmation)
Confirmation to an indication



Attributes

- Data are organized and exposed as attributes

Each Data element SN
. in the Server is «_ Data
» Each attribute has: called Attribute

Data
« A handle: it identifies the attribute on the server

- Atype (defined by Universal Unique ID - UUID): what the
value means
» 16-bit UUID: pre-defined by Bluetooth SIG
» 128-bit UUID: Vendor Specific identifiers

* Avalue (0 to 512 octets) Handle [Type ____|Vale

. Example 0x0009  «Device Name» Temperature Sensor

0x0022  «Battery State» 0x04
‘Yl — 0x0098  «Temperature» 0x0802

life.augmented

Data

Source : Bluetooth® SIG



GATT Profile

Profile

Service _
A GATT Profile defines how attributes are

Characteristic : oL
_ organized and how the application can
Characteristic access them.

- Attributes are organized in Services and
Characteristics

Service

Characteristic
Characteristic

a typical example:
1 service: “ARG” (Angular Rate and Gravity)
2 characteristics: “Gyro”, “Acc”
Values: [0,-1,+2], [-10,+15,+950]

life.augmente:



ST BLE Devices

Lys
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ST BlueTile

Lys
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Dual Core BLE

BlueNRG-2
BLES5.0 Application processor
Cortex-M0 32MHz, 256KB
QFN32, QFN48, WLCSP34

BlueNRG-1

BLE4.2 Application processor
Cortex-M0 32MHz, 160KB
QFN32, WLCSP34

BlueNRG-MS
BLE4.1 Network processor
QFN32, WLCSP34

ST BLE Portfolio

BlueNRG-LP
BLE5.0 Application processor
Cortex-M0+ 64MHz, 256KB
Flash, up to 36 GPIOs
QFN, WLCSP
(in development)

BlueNRG

STM32WBxx
BLE 5.0 Application processor
Dual core Cortex-M4 / MO+
Flash: 256K up to 1MB
RAM: 128K up to 256K
UQFN48, VQFN64, WLCSP100

w

STM32 ™
WB

PERFORMANCE




The lowest power

BlueNR

Processing power on

Flexible memory

Maximum security

consumption demand architecture Radio stack
>3 years lifetime on Low-power 256 KB eFLASH 70 kB FLASH ECC-256
CR20320) architecture. Cortex- 24 KB ULL SRAM 8 kB RAM AES-128
59 uA/MHz MO @ 32’MHz (with full SRAM data 0.9uA with full RAM Factory UID
0.9 pAsleep retention) retention Secure KEY
Seamless connection Robust and Small form
with SENSORS Reliable BLE Link factor

(*) Based on the average
current consumption in
connection mode (7.059 pA,
connection interval 1000 ms)

Lys
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Bluetooth
5.0 certified

)
@

Privacy 1.2 and

secure connection 4.2

Faster and more
reliable data transfer

Sensors

G-2 SoC at a Glance

Optimized BLE

BlueNRG




Bluetooth LE Programmable Processor

Flash PROGRAMMABLE
50 +8 BLE 5.0 Cortex MO with eFLASH
ULP radio dBm 32 MHz SRAM to host application code
24 KB
/ J

.
.
Advanced High-Performance Bus (AHB) |~ DMA |

( N\

PDM Decimation 12C lRTC
PROGRAMMABLE | HEGUEEY Il ) PROGRAMMABLE
PERIPHERALS ADC 101t | | ary oDC Digital 1/0
4 channels LDO
. J g /

g 7EEN
Bgi- y
-.!' y

©IAR  SIKEIL E=tollic

SYSTEMS Tools by ARM

"I STEVAL-IDB008V2 STEVAL-BCNO002V1B
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BlueTile Development Kit

Lys
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STEVAL BCNOO2V1 mem

SWD Connector Antenna

32KHz XTAL to enable ultra- - Balun
low-power BLE sleep mode / BALF-NRG
L2 bead to enable low- BLE SoC

power BLE active mode BlueNRG-232

{:;"]'J _J"" IS 3 . & x=9 7 :
User button =1 W E DS S| Pt @ RGBLED

Pressure Sensor
LPS22HH

Microphone
MP34DT05-A

Accelerometer + Gyro
LSM6DSO

12C for expansion

Bottom view

Magnetometer \
LIS2MDL

"I Time of Fllgh

..... ©.augmented VL53L1 X

Humidity + Temperature
HTS221




STEVAL-BCNO002V1 Block Diagram

Test points

RFTEST TEST ADC SDA SCL VDD GND antenna

ot

Matching
Network’ — RFTEST

BALF-NRG-02D3

Integrated balun

i User
L SMEDE0 UART_RXine
accelerometer + gyroscope IRQ ADC
LIS2MDL «m, BlueNRG-2 RGB LED
magnetometer IRQ Bluetooth 5.0 Network and

LPS22HH o Application processor MP34DT05-A
barometer microphone
1.6 MHz

400 .
HTS221 kHz 32 MHz
Relative Humidity & Temp. connector
KPR GaF4ll The 32kHz crystal enables lowest power BLE sleep mode.

The inductor enables lowest power BLE active mode.

VL53L1 M
time-of-flight proximity

life.augmented



STEVAL-BCNO0O02V1D

20-pin JTAG connector STEVAL-BCN002V1 Socket Micro-USB connector (bottom)

STLinkV3 socket

® o :
JILLS

‘W \ STM32L151 (bottom)

life.augmented



BlueTile SDK Overview

https://www.st.com/en/embedded-software/stsw-bluetile-dk.html

1. PC GUI Application to initialize the Radio params

0 . Application
. Docs ° 2. Doxygen Documentation
e ¥ Firmware 3. Pre-built FW examples/images
. Library o 4. Low level drivers and BLE stack/profile libraries
e . PCDriver 5. Virtual COM port drivers
. Project Q 6. Reference examples in source code
O (L vy 7. Utility section: IAR BlueNRG-2 Flasher

Lys
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Documents
- Open the Docs folder

10 WILITIBIE L ONMECTION_uIoENnes
| Radio_Driver
. Application . SPI_protocol_specification

« Device Datasheet

| | Docs. o STMBZAPIs Events_html
I\ Firmware Bl STMEZ SPL protocol eample bl - BLE stack documentation
. Library L STM32Z_UART_protocol_example_html « Release notes
& PCDrver b USE"W'EEHML_FW_“PEFWE-Fmffd”"? + APIs and events
& Project ||5_T.|f-"‘*‘iﬁ“—["Flm-l » Programming manual
L Utility L | license.bt

» Device (and kits)
documentation

e DOUble CIiCK on indeX.htm| + PCB design guidelines
» Bring up guide
» QGetting started

Lys
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Hands on Overview
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Labs Overview

« Lab 1: Getting started with STEVAL-BCNO002V1 “Serial Terminal Test”
» Lab 2: Connecting to the ST BLE Sensor app

- Lab 3: LED characteristic

- Lab 4: Accelerometer embedded events detection

- Lab 5: 9-axis Acc+Gyro+Mag Sensor Data Fusion

- Lab 6: Cloud data logging on IBM Watson

- Lab 7: Voice over BLE

o7
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Lab 1

Getting Started with STEVAL-BCN002V1B
“Serial Terminal Test”

life.augmented



“Serial Terminal Test”

* Plug the BlueTile to the PC using the USB cable

- Install and open Tera Term and configure serial terminal




Connect Your STEVAL-BCNO0O0O2V1B
to the PC Using USB

4.1 Favorites
BE Desktop
i Downloads
"5 Recent Places

4 Libraries
L B Documents
o g Music

I =l Pictures

Connect the USB cable

The BlueTile comes already
connected to the daughterboard

é “gﬂidulujhﬁjum” i
)

I 'Q ;;@;

T Iﬂwwwﬂuuw]m \.

\

a W Computer

b E 05Dk ()

" BCNOD2VL (D)

e e e o ; \

‘_ o On the PC file system a
/4

BCNOO02V1 drive will appear
..... e.augmented



Windows7: Allow the Driver Installation

1. Click on Install driver software
anyway

® 2. Installation starts

. ..EJ

-) Don't mla!ﬂnsdﬂmmﬂuaﬂ:

mnﬁmﬂ theck your manufecturer’s website for updated driver saftware for yaur

| Install this driver Software anyway.
wwmmmﬁmmmmam
Unsigned softwar information

e from other sources may harm your computer or steal|

;[ seadetals




Virtual COM Port Driver

If you have issue with the STMicroelectronics Virtual COM

Port device driver installation here the iInstructions for
installing the Virtual COM port driver:

Win7 Win10




Tera Term Configuration 1/4

o

Host: |myhost.example.com

History .
ervice: | Telnet [ CPportl: (22
u-SS5H SSHwversion: |$SHZ

Other g 5
Pratocol, |UNSPEC: -

0 Port: |(;_30 M31: STMicroelectronics Virtual C.Qh-v|

‘ Cancel ‘ | Help |

1. Select the STMicroelectronics Virtual COM Port

 NOTE: on Win10 PC the serial port is labeled just as “COMxx”
Lys 2. Click OK

life.augmented



Tera Term Configuration 2/4
1. In Setup -> Serial port...

Set the following:
Baud rate : 115200 Port: o COM91 oK
. Baud rate: 115200 -
Data : 8 bit i
B} Data: 8 bit Cancel
Parity : none Cari none
StOp . 1 bit I Stop: 1 bit Help
Flow control : none Flow control: ~ [none

Transmit delay

0 msecichar 0 mseclline:

2. Click OK
&7

lite.augmented




Tera Term Configuration 3/4

1. In Setup -> Terminal... set
New-line Recelve:
AUTO

2. Click OK

.-;--l-:' l:l.:.i..f_-::.'t.':?:i"‘ -
Terminal size 0 New-line .
' B QK 2

Transmit: M ‘ CGancl ‘

| Auto switch (VT¢STEK)

Wi Term size = win size

Ll Auto window resize

Terminal ID: | VT100 '_‘

Answerback:

[~ Local echo

Coding (transmit)
UTF8 -]

CodePage: 65001

Coding (receive)

locale: american



Tera Term Configuration 4/4
1. Click Setup->Save setup...

o

2. Click Save

[ Tera Term: Save setup |§ |
e
L -;u | o Computer » Windows (C:) » Progrem Files (:86) » tersterm: v - | +4 || Seqrch teroterm 2
a Crgamize » New falder ESEC l&
s " 2 Name Datz modified Type Size
o Favarites
B Desktop . cygterm+-1G8G 57472018 6:57 PM Filefolder
4 Downloads . cygterm+-xB6_64 54472018 G:57 M File folder
Ul RecentPlaces ||| L fang S/4/AIRESTEM Filetalder
& Windows (C) . plugin S/4AMEESTPM File falder
ca LocalDisk (D) 1 . theme 544 /218 8:57 PM File foldes
& | TERATERM.INI 114772018 10:52 AM  Configuration sett 1 KB

A Libraries

b Computer
BT e e

File name: TERATER:MINI -

Save astype: |setup files (Nini)

= Hide Folders

Lys
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Help

|| save df;_anca




Push on the daughterboard

‘ Tl COMISET - Tera Term VT

| Fle: Edit Sstup Control Winde He

# STEUAL-BCHBBZU1 #

Scan for sensoprs:
Accelerometer and Guroscope: 0K
Pressure and Temperature: 0K
Humidity and Temperature: 0K
Magnetometer: 0K
Proximity Sensor: 0K
Sensor in low-pouwer: OK
Hattery voltage is 3278mU: OK
DTA update is NOT supported
Device 'BCH-B02' discoverable with MAGC: FF:29:bS:icbicaic?

-
-
o
]
-,
"
in

'

If you see the output above, IS now properly configured
1S7;
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Lab 2
Connect to the ST BLE Sensor App

life.augmented



Customize YOUR STEVAL-BCNO002V1

SIKEIL  “&7, &
Tools by ARM & ;
HVision=5 |

Integrated Developme

+ STEVAL-BCNO02V1 DK
Sensor Demo ref FW

CEEET—

\".s BCN-034
BishAB 1A:AT:E3:3F:E7:ES




BLE_ SensorDemo Application

1. In the BlueTile SDK browse the following path: STEVAL-
BCNO002V1 DK 1.1.0\Project\BLE_Examples

s [ o [ [

, BLE_Beacaon

. BLE_Chat

. BLE_HID_Peripheral

. BLE_OTA_ResetManager

BLE OTA Servi er The BLE_SensorDemo
. BLE SensorDemo | ‘ embedded application is the

T — — -

. BLE_Throughput
. BLE_Throughput_EXT
. DTM

main reference



Integrated Development Environment
Arm Keil MDK

* MDK: Microcontroller Development Kit

« Complete software development environment from Arm for a wide range of
Arm Cortex-M based microcontroller devices.

 MDK includes the pVision IDE, debugger, and Arm C/C++ compiler

- A FREE license is available for ST BlueNRG-2
« Go HERE to get the free license!

l“YI
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BLE SensorDemo Application

; =8 X

®ad]s ool = 2 1 1] B oo 3 4] @) 5 6 AT N

= it Project: BLE SensarDemo
45 Relense:
8 [ BlueNRGI_Periph_Driver
&3 Platforms Layers
1] SDK EVAL Comi.c
SDK_EVAL Canfig.e
1) SDK_EVAL Button.c
[ sox.EvALDCe
1] SDK EVAL Led.c
B FFF’S?IE.G;
) Us2mMDLe
1] LPSZZHH.
LSMEDSL.e
1] LSMBDsO.c
@ |3 stertup
D User
(] BlueNRGL it.e
L‘; g@ﬁ_d_b.r-_
EI SEMSOTL
1 SensorDemo_main.c
@3 Hal
5 5 Stack
11 libbluenrgl stacka
] stack_user_ cfy.c
L tiberypto.a
& (4 OTA
@ 3 visx
5 5 MationFX
| 13 MationfX100 CMOP Keil ctib
= 5 BlueNRGL BlueVoice Library
[ bluevoiceADPCM BNRGL 100 Keil i

i @?(ﬁuzﬁt :e‘ﬁwh | £} Funetions \ﬂ;T:!ﬂnrnm |




oiin i

e Application Structure

& [ BlueNRG1_Periph_Diiver
& L5 Platforms_Layers
1] SDK_EVAL Cém.c
| ] sDk_EVAL Config.c
|4] SDK_EVAL Buttonic
S SorRALRCe = HW peripherals drivers and platform layer files
| HTs221.c
] LIS2MBL
|1 LPS22HH.c
1] LSM6EDS0.C
w3 Startup
&= & User

T Application source code
L] BlueNRGL it.c - Main

) gott dbic [ - ATTRIBUTE Database

|] sensarc

D ‘Sensorlemo_main.c - Application

I_i'l HWaAdvanceFeatures.c —
@ —_}— Hardware Abstraction Layer and sleep management
1 D libbluenrgl_stack.a ) ) . .

aEE stack user_cfg.c BLE Stack library — provided in binary format

liberypto.a

= OTA -
& O3 VIsILx
= F MotionFX

1S72 2 Mot e et __p— Sensor Data Fusion library

)\

=l L5 BlueNRGL_BlueVoice Library

life.augmented & htuemicmﬂpEM_BNRGI_maﬂKeir.nt} Voice over BLE Iibrary



A Look at the Main Application

int main(void) {

Systeminit(); | Remap the vector table and configure all the interrupts priority

I

SdkEvalldentification(); | Identifies STEVAL or custom PCB

\

Platforminit(); | HW peripherals initialization

|

BlueNRG_Stack_lInitialization(&BlueNRG_Stack_Init_params);| BLE stack initialization

Sensor_Devicelnit(); | Sensors initialization

|

Set_DeviceConnectable();| Set device in advertising

|

while(1){ | Start of while loop

BTLE_StackTick();] Advances the stack FSM
User_AppTick();] Advances the application FSM. THIS IS DEVELOPERS USER SPACE!

:’7 } // end while(1)
}

J
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Step 2: Scan

Master is in discovery mode
looking for a specific slave to connect to

step 3: Connection request {

1

step 4: Services & Chars

discovery
Master (Client) starts the BLE Service
and Characteristics discovery procedure
to understand the Server ATT DB

Lys
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Advertise

Advertise
: Advertise
€

Connection request

Connection created

Service & Characteristics
discovery

Notification

A

-

I1 00msecs

Notification

S

Slave is in Peripheral mode and
sends ADV_IND PDU

step 5: Data flow

Slave (Server) starts sending
periodically (100 ms) to the master,
notifications packets of sensors
values (acc&gyro and pressure)



’

=
I“E

EK‘FT

Step 2: Scan

Master is in discovery mode looking
for a specific slave to connect to

step 3: Connection request {

Master:

needs an app for
discovering the slave
ST15 device in advertising

life.augmented

Advertising and Scanning
Central (((9)))

Advertise

Advertise Step 1: AdvertiSing
Slave is in Peripheral mode and

sends ADV_IND PDU

Advertise

Connection request

Connection created

Off-the-shelf app: e.g. Custom app: e.g.

24

LightBlue® Explorer

https://itunes.apple.com/us/app/lightblue-explorer/id557428110?mt=8
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LightBlue scan results

®e000 Verizon LTE 10:31

Sort LightBlue | Explorer

@ 7 0 } 7% m.)

Filter

|,,|| BCN-034
51 No services

4 Unnamed
-16 No services

Gear S3 (385D) LE

-89 sarvices

. BCN-002

-8 No services

GoogleHome3429

-8 1service

BlueMS1

-1 No services

Unnamed
-95 No services

Unnamed
-89 No services

MetaWear
-86 1aervice
Info | PunchThrough

Log

Lys
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Scan R

ST BLE Sensor scan results

see00 Verizon LTE 10:30

< Back Devices

@ 7 @ ¢ 87% =

X

S5\ BCN-034

1A:AT:E3:3F:E7:E5

—
) BCN-002

D3:D0:38:ED:C2:E4

esults

Why some devices are not present
in the ST BLE Sensor app?

How devices will pop up in

the STBLE S

ensor scan list?



ST BlueMS Protocol

* In order to be connected to the ST BLE Sensor app, a BLE peripheral
SHALL comply with a specific advertising packet format

- ST BlueMS protocol specifies a 26-byte packet format composed of
Advertisement Types — ADTypes - compliant with BT SIG definitions

Pre Acc Addr ,es. AdvA AD Flags BlueMS Adv Packet
Type | fooce! | Perice | Feature Device MAC Len | Type | Local Name | Len Type  Pwr
K 1 1 1 4 6 K 1 7 | 1 1)
| |
Manufacturer Specific Complete Local Name  TX Out Power
ADType ADType ADType
Len=13 Len=8 Len=2

"I Type = OxFF Type = 0x09 Type = 0x0A



BlueST SDK for Android and |OS gz=

GitHub This repasitory  Search Explore Features Enterprise Pricing
: icroele ics-Cen S ue & i
L_| STMicroelectronics-CentralLabs / BlueSTSDK_Android O My 3
]
A n d r O I d Bluetooth low energy Sensors Technology Software Development Kit (Android version)

https://github.com/stmicroelectronics-centrallabs/bluestsdk android D2 commis 2 branches © 0 releases & 1 contibutor
m Branch master~ BlueSTSDK_Android / + =
% GiovanniVisentini Update README Latest commil 573ce4 10 days ago
I BlueSTExample Initial commit 14 days ago
I BlueSTSDK Initial commit 14 days ago
E] .gitignore Initial commit 14 days ago
= B LICENSE Initial commit 14 days ago
ource coaeit1ori dan T
B build gradie Initial commit 14 days ago

u

A n d ro I d E) settings.gradle Initial commit 14 days ago
.| STMicroelectronics-CentralLabs / BlueSTSDK_iOS ©@Watch 3

available online and maintained on GitHub repos

Bluetooth low energy Sensors Technology Software Development Kit (iOSversion)

u = 4 5
I o S 0 2 commits ¥ 2 branches O 0 releases G 1 contributor

. . . . LGl Beanch master~ | BlueSTSDK_iOS / + i=
https://github.com/stmicroelectronics-centrallabs/bluestsdk ios -

% GiovanniVisentini fix parse error with multiple feature in the same characteristics = Latest commit c@e8d1 2 days ago

B BlueSTSDK fix parse error with multiple feature in the same charactenstics 2 days ago

‘ ,I B BlueSTSDKExample fix parse error with multiple feature in the same charactenislics 2 days ago
B) LICENSE Initial commit 9 days ago

life.augmented
g B} Readme.md Initial commit 9 days ago



ST BLE Sensor Scan Results

Len | Type | Frowocol Dﬁ‘gce F:naat:lze Device MAC Len | Type | Local Name
sesco Verizon LTE 10:30 @ 7 0§ 87% wm>
¢ Back Devices x Each ST Platform is recognized by means of a
Device ID
) Bonv-oo2 (for STEVAL-BCNOO02V1 it is equal to 0x05)

Users can distinguish their node from \\
the Local Name \'\
BlueNRG




____Customize Your BlueTile

= 1§ Praject BLE SensorDemo
= g Release
4 BlueMRGL_Periph_Driver
& O Platforms_Layers
W Startup
=& User
L] BlueNRGL it.c
|1 gatt db.c

1 =ensorc

|j SensorDemo_main.c
] HWAdvanceFeatures.c
|_"| hw_config.c

w3 Hal

i [ Stack

# i OTA

@ O VES3LIX

W 8 MotionFX

ﬁ @ [ BlushRGl_BlusVoice Library

life.augmented



Customize Your BlueTile mm

Modify the local hame in the advertisement payload

1. In the file Sensor.c go to line 52

2. “BCN-002” is the default local name value
3. You can modify it as you prefer with a 7-characters string

#define DEFAULT NAME ALLMEMS




Build the New Code

1. Click on the Build button (top left corner)
_ File Edit WView Project Flash Debug Peri
or hit F7 on your keyboard T B9 | -
2. In the Build Output window (bottom) wait for - 4 e | W retense
the build to be completed. - EET——
. BLE_SensorDemo.bin created E‘“ﬂ!ﬁ Sl Sorek THeS o
=453 Release
* “0 Error(s), 0 Warning(s)” message appear

In P CTEUAY 2
R TiHe Hand=sOnha = :

Build Cutput
e 15311_wait. Cuuw

compiling v15311 register funcs.c...

compiling v15311 platform.c...

linking...

Program Size: Code=121908 RO-data=1428 RW-data=1136 ZI-data=21252

FromELF: creating hex file...
Lfter Build - User command #1: fromelf.exe —-bin ..%..%..\..\..\..\Handzfes - ELE SensorDemo.axf —-output ..%\..%..\..\. .. \HandsOn\BLE_ SensorDemo PrjCutput\BLE SensorDemc.bin

"o \HandsOn\BLE_SensorDemo PrjCutput\BLE SensorDemo. axf"'h‘ L 0 Error (s), O W;ming (=) .
Build Time Elapsed: 00:00:12

Lys
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Programming Embedded Flash

1. UART Bootloader
« ROM bootloader. HW activation through dedicate pin (DIO7) configured for Boot

« PC interface named “BlueNRG-1_2 Flasher Utility” available in the SW package

2. SWD interface + ST-LINK
* Interface with the STEVAL-BCNO002V1 through the 20-pin JTAG connector
« Same PC interface “BlueNRG-1_2 Flasher Utility”

e

- 2 L —
“\F?ﬁ% + v, BSOE s

"I Nucleo

life.augmented

Remove CN2 Jumpers
and plug daughterboard
on top




Flash Memory Layout 1/2

SDK Projects

0x1007E800
OTA h|g her app BLE_SensorDemo_HigherApp_OTA
( 1 24kB) BLE_Chat_Server_HigherApp_OTA

0x1005F800
OTA lower app BLE_SensorDemo_LowerApp_OTA
(1 24kB) BLE_Chat_Server_LowerApp_OTA

0x10040800

Reset manager (2kB) BLE_OTA_ResetManager
0x10040000

BlueNRG-2 Flash
‘YI

life.augmented



0x1007F000

0x10051800

0x10040000

Flash Memory Layout 2/2

Application
with no OTA service
(182kB)

OTA Service
Manager
(70kB)

BlueNRG-2 Flash

SDK Projects

BLE_SensorDemo_Use_ OTA_ ServiceManager
BLE_Chat_Server_Use_OTA_ServiceManager

BLE_Beacon_Use_ OTA_ServiceManager

BLE_OTA_ServiceManager



UART Bootloader: Use the BlueNRG
-
Flasher Ultility

* On st.com at this link:

https://www.st.com/en/embedded-software/stsw-bnrgflasher.himl

STSW-BNRGFLASHER = Print M SavetomysT Share via Email

BlueNRG-1, BlueNRG-2 Flasher ufility

Overview Resources

The STSW-BNRGFLASHER is a standalone PC application which allows the BlueNRG-1, BlueNRG-2
devices Flash to be read, mass erased, written and programmed.

Lys
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Open the BlueNRG Flasher Utility sz

1. Go to
C:\Program Files (x86)\STMicroelectronics\BlueNRG-1_2 Flasher Utility 3.0.0\Application
o5 Bloehfe-1 2 acher - Uiy 200 o

1. Double click on BlueNRG-1 Flasher GUl.exe ===

Flash from Address: | 010010000

Action: £ COM Parts:
71 Automs oKy g
V] Verify
|71 Mass erase.
1] Update Device Memory.

Device

Flash Programming




For HD Screens...If You've Screen Resolution problems
* Right Click on the .exe file and select Properties

- In the Compatibility tab select either Disable display scaling... or

Override high DPI scaling... —> Application

Lys
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L ey R
|7 BlueNRG-E =
| BlueNRG-1 . P
[ bszaya #  Runas administratar
|_.: Micrasaft i Troubleshoot compatibility
& mevemsod| 2P ¥
%] msvepao,n|  CRCSHA x
% mayerd0,di | = Edit with Notepad-+
|| PyQtd.GtCo Scan for Viruses..,
|| PyQt.Ct6ul & winMerge
P
(% pythonZZ.di Unpin from Taskbar
|§i pywintypes2 Pinto Start Menu
!& GtCored.dll Restore previous versions
% QtGud.di —
|4 QtopentGLy| ~ SEndie x
1% QtSvad.dl cut
] Qemid.dll Copy
|| select.pyd
BT Create shortcuit
O uieosemsed| D=
Rename
3350 PM —
Properties

&7 BlueMRG-1_2 Flasher GUl.exe Properties

¥ this program lsn't working comectly on this version of Windows,

try rrming the troublestioater.
How do | choose compatibility sstigs marwaihy?

Compatibilty mode
] Run this program in compatibiity mode for:

Wiodows 2

Settings
] Reducad color mede

bE 255 ooir

I [ Chsabis display scaling on high DP| settings

|1 Rue this program as an administratar

Q_ﬂa-mm forall usarm |

X

]
&7 BlueNRG-1_2_Flasher_GUl.exe Properties

General || Compatibdty | Securty  Detads  Previous Veriona

I this program ksnt working comectly on this version of Windows.

try unning the compeatibiiity troubleshocter
[Flm' Iiilli!'ﬁ']
How do | ehoose compatibiity settings rmiiwialy T

Compatibity mode
[[] Run this program in compatibiity mode for:

| e
Pmidehy\ DPF| scafing behavior.

| Applcation v

] i this program a4 an admiristratar

Ok || Cocal |




BlueNRG Flasher Utility mem

Fil= ool Help

2 e e
SelectImage file | No/Image filefo . | Select Image file | No Image file Inadsd.
Flash from Address: |0 10040000 |1 Fmsh ] swp | = = -
uaRT [swp U A R I Flash from Address: |[x 10050000 | | Fizsh | | Siog
Actions. List of COM Ports: U
ART f
S — -
7] verify Actions List of COM Ports:
[¥] Update Divice Memory |J Automatic Mode {only ST OK) ._I 29 J
IR
V] verify [T cones
Device N
ki Progtatiiog [ Mass srase
|
|7 B [¥] Update Device Memory
Device Memory Image Fie
Start Address 0x10050000 Size 0x3000 Read ][ W= |
0 1 2 3 s 5 6
SelectImage fle | No Image fie loaded,
il i1 i ' £ 1
Flash from Address: | (010040000 |l Fasl 1] kg |
Log
uml swo |
AActions: [T Mac Addeess
] Automatic Mad= MAC Address: Starf: GrBOROBONONID - End: CrOENOTONONT
9] verify
MAC Flash Location Ox 10067553
|| rReaduout Protection | |
Loadlog,. | v toghia I dGleitony I I e— || Save MAC Address Loe.  File Name |
N.Board: 0/ || | 0% [7] Update Deyice Memary { Seit Mse Address,. |
g J




Flash the BlueNF

1. Select the COM port labeled (ST DK)

UART | swp |

G-2 1/6 ==

Achons -
| Automatic Made (only ST DK)

] verify

Lizt of COM Ports:

[¥] COMS1 (ST DK




Flash the BlueNRG-2 2/6

2. Device Memory will populate with data

Device BlueNRG-2 {mayx fiash address: 0x1007FF)

| Device Memory COM21 l Image Fie |

Start Address 0x 10040000 Size 03000 [ Read || Wi
B = 2 -F £ =5 6 4 B 2 W 3 I IF 3 15 ASCH e
(10040000 00 60 OO 20 D9 O7 04 10 35 06 04 10 3D 06 04 10 U5 = IJ

010040010 AA 55 55 AA 00 00 00 0D 00 OO 0D OO0 OO0 00 OO0 00 SULE

00 00 00 00 45 06 04 10 -

8

(x10040020 00 00 00 00 00 00 00

0x10040030 00 00 00 0O 00 00 00 0O 4F 06 O4 10 S3 06 O4 10 oY L

Log

1£:10:30.632: Dewice COMS1 —> Head Bosrd Sterted
16:40-31_701: Deviee OC0MS1 —> Hisd Hosrd Znd

Lys
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K > /4

UART | SwWDo

Flash the BlueNRG-2 3/6

3. Select VMlass Erase

Actions

7] Automatic Made (anly 5T 0K
(W] Verify

|71 Mass erase

W] Lpdate Device Memary

List of COM Ports;

|¥| comat (ST BK)

‘

Actions List of COM Ports:
7] Automatic Mode (anly 5T DK) 1¥] comaL (5T DK)
] Verify

@Massaﬁse

[¥! Update Dievice Memory




Flash the BlueNRG-2 4/6

4. Click on the Select Image file button

kw7 BlueNRG-1_2 Flasher - Utility v2.0.0

] | .M

| Select Imags file || No Image fie foaded,

5. And browse the following path

STEVAL-BCNOOZVL DK110 » Project » BLE Bramples » BLE SensorDemo b MDK-ARM » BlusNRG-2 » LowerApp GTA » Dhjects




Flash the BlueNRG-2 5/6

6. Select the binary file (e.g. BLE_SensorDemo_LowerApp_OTA.bin)
and click Open

/. Insert the correct start address (e.g. 0x10040800 for Lower App)
8. Click on the Flash button

&7 BlueNRG-1_2 Flasher - Utility v3.0.0

[seectimsgeqie | /isemsiraffucle rvaDeskiop/TestAlucTie D1, 120100525 STEVALBCNOBRV L DK 1.1,0/SFEVA-DENBERY LI
1,1 0/Pro xampies/BLE - SensorDemo/MER-ARM/BluehRG-2 LowerApo. OTA/Objedts/BLE_SensorDemo_LowerApp OTA.bin

10040800

ﬁﬁﬁﬁﬁ et A F TP Dt



Flash the BlueNRG-2 6/6

9. Flashing starts: green bar proceeding
Device BlueNRG-2 [max flash address: 0x1007FFF)

P

10.Wait for the pop-up window and click on OK

Device BlughRG-2 (max flash address: 0x1007fffT)
Reading Memory COM91

57 BlueNRG-1 2 Flasher - Utifity

Deyvice Memory COM31 | Imags File: |

~ || & DeviceCOMIL =5 Flashed and Vesified,
Start Address 0x 10040000 é Read | Wi

5 A:ooF 3 Ascn -
0x10040000 00 60 00 20 O | E
0x10040010° AA 55 55 AA 45 55 4C 42 00 OO 00 00 00 00 00 GULSEULE
00040020 00 G0 00 00 00 G0 00 G0 00 G0 00 00 2 12 04 1D !
(:10040030 D00 00 00 00 00 00 00 00 D7 06 04 10 23 12 04 10 . = _

Lo

2

ww&START FLASH ODERRTITN%*+
Flash Beoards:; COM31 (ST DE)
16:17:31.612: Device COMS1 -> Flash Frogramming

‘ A&-IT:32.171; Device C{fm!il —= Hesd Soard Sterved
1£:17:32_EB84: Deviee COMS! —> Rssd Board Znd

1E:1T:32_917: Dewice COMSL <> Flazhed ‘and Verified.

life.augmented



SWD: Use BlueNRG ST-LINK Utility

* On st.com at this link:

https://www.st.com/en/embedded-software/stsw-bnrg1stlink.html

STSW-BNRGI1STLINK | s & Print @ save o MysST Share via Email

BlueNRG-1 ST-LINK utility for BlueNRG-1, BlueNRG-2 MCU

Get Software Download databrief

Overview Resources

The BlueNRG-1 ST-LINK utility is a full-featured software interface for programming BlueNRG-1 and
BlueNRG-2 devices.

Lys
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1.

Programming Embedded Fl

SWD interface + ST-LINK

life.augmented

[

B, BlusNRG-1 ST-LINK Utiity

File Edit View Target ST-LINK Help

Hd @202 8

Memory lﬁs‘:ﬂl_a\d I Device BluehRG-2
Address:  0x10040800 - Size: (U 16FAS Dats Width: 32hits = Revison  Revd
s Flash size 256K ytes
| Device Memory @ 0x 10040500 ¢ | Binary Fie | [Ctivelipdate
Target memory, Address range; [0x 10040800 0x10057748]

Address ] |4 |s (S ASCH =
DAO040B00 (20006000 10047640 004783 1004793 0 Mv..ly.3y. i
0:10040810 AASSSSAA 424(5545 _Uﬂﬂﬂﬂﬂﬂﬂ _Uﬂﬂﬂﬂﬂﬂﬂ FUUEULB..L
010040820 00000000 _ouamuao _Omﬂﬂﬁ _1004?935' Vi Y
010040830 00000000 00000000  100474AF 10047939
| SDOIDEIG 10657050"  0OHIEL  o00oaoos jondaonan
010040850 100479B5 | 10047463 | 100479C9 | 100474BF
0x10040870 00000000 100474C1 10047403 10M474Cs ... At At At
0x10040880 00000000 10047485 10047467 10047489 RV T T -
¢ Ll M ol ¢
03:43:03 : STAINK SN : ST U065088435348330487
03:43;:03 + STHINK Firmwiare version ; V213157
03:43:03 : Conrected via SWD.

03:43:03 ; SWD Frequency = 4,0 MHz,

03:43:03 : Connection mode : Narmal,

43: I:Big\dce‘: NuﬂG—Z
: Device family ;BlueMNRG-2
03:43:03: Device flash Size : 256KBytes
I
i ,E)ebug in Low Power mode enabled. Pewce : BlushRG-2 (Cope State © e pdatm Dissbien
s




Open the ST BLE Sensor App

Download on the wll Verizon LTE 17:43 70 % 99% ) 4
S App Store

GET IT ON

P> Google Play

Launch the ST BLE Sensor
app previously installed

Connect to a device

Note: in the following slides all the pictures are
referred to the iOS version of the ST BLE Sensor app. AR
‘Y— The Android version is slightly different Version: 422

{e.augmented



Connect Using the ST BLE Sensor App
@ 2 o

Tap Select your You are
“Connect to a device” BlueTile connected
all Verizon LTE 17:43 7 O B 99% =4 ‘(’ Bac: on LTE D;::;s wi 33%: -::::: LTE 10:42 @T1o%f 857;
BCN-034
1A:AT:E3:3F:E7:ES ’ =
© " . «% | Blow air on
N ¥ the
ﬂ L00k for YOUR 3570°C Not Present Temperature
- 32,50 °C
A\ Local name sensor to
Connect to a device before Change the
< connecting! l, temperature
@ N’ and humidity
— 1013.73 mBar 51.50 % Val u es



« “Device connected” will appear as connection is created
« Each time user moves on different tabs/screens in the app:

 BLE notifications on different BLE characteristics are enabled.
« Environmental and Gas Gauge/Battery characteristics are involved

T COMDL - Tera Term VT

!Erle Edit Setup Control Window Help

kit STEURL-BCHNBBOZU1 H#H

can for sensoprs:
Accelerometer and Gyroscope: OH
Pressure and Temperature: 0K
Humidity and Temperature: OH
Magnetometer: 0K
Proximity Sensopr: 0K
ensor in low—power mode: OK
Battery voltage is 3.31v: OH
Nevice iz _nnw _dizcoverahle with MAC: FYP:c1:18:@7:28:-0h
flevice connected
jLa il 1nPrat1inon statius l"'Eﬂ'llEStEd
nuvironmental Motification OM
nuironmental Wotification OFF
ﬁ Gas Gauge Motification ON
YI Gas Gauge Motification OFF
nuironmental Motification OM

fe.augmented ) i gt |
Environmental Motification OFF




In file sensor.c

Feature
Mask

Protocol | Device

Len version ID

Type

ST BlueMS Protocol mm

Device MAC Len Local Name Len Pwr

Type

Type

H#if ENABLE MOTIONFX
400 0x05, /* AccEvents + iNemo Compact */

OXFE, /* Agg + Gyro + Mag + Press + Hum + Temp + Bagg*

389 Lot E S it e O L B L O O oD e D dRn bk Tﬂﬂqnission Power 3 byteS TX output power
390 e EOTLULTNAME- LI IUIISS b St s

391 13, /* Length*/0OxFF, O0x01, /% SKD version *

392 0x05,/* 0x05 BlueNRG-Tile Board */ 9 bytes Local Name

353 L #if ENABLE BLUEVOICE

394 Ox6k, /* ADPCM Sync + ADPCM Audio + Led + Brox */

395 #else

396 0x22, /% Led + Prox */

397 -§endif

398

13 bytes Manufacturer Specific

life.augmented

401 0x40, /% eCompass */

402 felse

403 0x0%, /* AccEvents */

404 0x00,

405 -#endif

406 0x00, /* BLE MAC start */

407 0x00, 0x00, Ox00, Ox00, Ox00, /* BLE MAC stop */
408 = 1



BlueMS Protocol

4 Bytes Complete Feature Mask

Protocol | Device Feature .
version D Mask Device MAC Len | Type | Local Name Len Type

| 81

Ox6A

SensFus | Compass | Motionint Activity  Carry Pos MemsGes ProxGes Pedo

ugm 1d



How Feature Mask is Mapped onto ATT DB?

- 3 services: HWServW2ST, Config,
and Console

HWServW2ST

Environmental

- Each bit of the 4-byte Feature Mask Acc Gyro Mag LED
In the Advertising packet Quaternions
corresponds to a HW/SW feature

* In the Server ATT DB a BLE ADPCM Synch
Characteristic has to be added for
each bit of the Advertising Feature Console

Mask Config Char Term Char

STDERR Char
Ly

life.augmented




BLE SensorDemo ATT DB

= 1f Project BLE SensorDemc
= %% Release
il 4 BlueMRGL_Periph_Driver
i [ Platforms_Layers
L Startup
=3 User

L] BlueNRGL it.c The ATT DB is defined and

1 gatt_db.c
T sensore created in the file gatt db.c
] SensorDemo_main.c -

L] HWAdvanceFeatures.c

|j hw_config.c

2§ Hal

& [ Stack

w i OTA

@ O VLS3LIX

w4 MotionFX

EI Q| BlueMRGl_BlueVoice Library




BLE SensorDemo ATT DB

ATT DB
HWServWi2ST
Environmental 12 N,R 128-bit 001D0000000111e1ac360002a5d5c51b
Acc Gyro Mag 20 N 128-bit 00E00000000111e1ac360002a5d5¢c51b
Acc Events 5 N,R 128-bit 00000400000111e1ac360002a5d5c51b
Battery 9 N,R 128-bit 00020000000111e1ac360002a5d5c51b
Prox 4 N,R 128-bit 02000000000111e1ac360002a5d5¢c51b
LED 3 N,R 128-bit 20000000000111e1ac360002a5d5¢c51b
Quaternions 8 N 128-bit 00000100000111e1ac360002a5d5c51b
Ecompass 4 N 128-bit 00000040000111e1ac360002a5d5¢c51b
ADPCM 20 N 128-bit 08000000000111e1ac360002a5d5¢c51b
ADPCM synch 6 N 128-bit 40000000000111e1ac360002a5d5¢c51b

NOTE: two additional bytes for a timestamp for each char



Example: Battery Characteristic
nnmm-mmm 0x00

ADPCM Switch ADPC MicLevel  Proximity

mmnmn 0x02

Gyro Pressure  Humidity = Temperat

-mnnmn 0x00
Beamform AccEvent FreeFall
-nnnnn B ox00

SensFus Compass  Motionint Activity  Carry Pos MemsGge~ ProxGes Pedo

UUID VALUE

HWServW2ST 00020000000111e1ac360002a5d5¢51b

The UUID values are linked to

the Feature Mask in advertising




BLE SensorDemo ATT DB mm

Each characteristic is defined by the following key parameters

PROPERTIES | UUID TYPE UUID VALUE

20 N,R 128-bit 00000001000E11e1ac360002a5d5¢c51b

STDERR 20 N,R 128-bit  00000002000E11e1ac360002a5d5¢c51b

/

This byte differentiates the Service

20 N, Ww/oR, 128-bit 00000002000F11e1ac360002a5d5¢51b
R,W




BLE SensorDemo ATT DB

tBleStatus Add_HWServW2ST_ Service (void)

aci_gatt_add_service (UUID_TYPE, UUID,..,MAX_NB_ATTRIBUTES, &ServHandle)

aci_gatt_add_char (ServHandle, UUID_TYPE, UUID, Length, PROPERTIES, PERMISSIONS, .., §CharHandle)

HWServW2ST

HWServW2STHandle = 0x000C

Environmental — FEnvironmentalCharHandle = 0x000D

AccGyroMagCharHandle = 0x0010

Config — ConfigW2STHandle = 0x002B
Config Char —— ConfigCharHandle = 0x002C




BLE SensorDemo ATT DB

Char Declaration EnvironmentalCharHandle = 0x000D

X

Environmental
~

- Declaration Handle: used by the application to access the Characteristic

Char Value Handle = 0x000E

Char CCCD Handle = 0x000F

- Characteristic Value Handle: used by the Client for Read/Write operations

* Client Characteristic Configurator Descriptor (CCCD): a GATT
descriptor is added by default by the stack, if char has Notify/Indicate property.
Used by Client to enable notifications/indications on char value.

Lys
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Central: Services and Characteristics
Discovery Procedure

UUIDs Handles
‘Name Handle Property Value Values ValueLength‘

a i Service User Defined {0x000000

a [l Characteristic User Defined| (0001 DOD00000111 ELAC36000245D5C51 B 04000D Read, Motify lU:dJnFUHlUBCOUUlBEQCAEGS]U:d]C
B Client Charscteristic Calhg on 2] T 032

4 @ Characteristic User Defined ((x00E00000000111 E1 AC360002A505C518) 0x0010 Motify
n Client Charactenstic Configuration (0x:2902) 00012 (0000 2
- - a [l Characteristic User Defined (0x00000400000111 ELAC360002A5D5CS1B) 040013 Read, Motify 00000002405 005
Th I s I s h ow B8 Client Charactenstic Canfiguration (0x2902) 00015 00000 32
o [l Characteristic User Defined (0020000000001 11 EL ACIE0002ASD5C51R) 0:0016 Read, Naotify 0x88A1232E Oulid
Client Charactenstic Configuration (0x2902) O0018 (0000 2
ATT D B a [l Characteristic User Defined (0x20000000000111 ELAC350002A5D5C518) 030013 Read, Matify 0x0024E6 0x03
& Client Charactenstic Canfiguration (0x2302) 0x001E OhCO00 2
- « [ Characteristic User Defined (0:x00020000000111 ELACI60002A5D5C51B) 0x001C Read, Motify Ox0130000CBEADSERABRT Ox08
I oo ks I I ke Il Client Characteristic Configuration (0x2902) 0:001E Ox(000 o2

a [l Characteristic User Defined (0x00000100000111 ELAC350002A5D5C518) 0400LF Motify
fro m t h e B Client Characteristic Canfiguration (0x2902) 0:0021 00000 002

« @ Characteristic User Defined (0000004000011 F1 AC360002ASD5C51E) 0:0022 Notify
Client Charactenstic Configuration (0:2902) 00024 (0000 2

Ce nt r a I a [l Characteristic User Defined (0x08000000000111 E1 AC350002A5D5C518) 040025 Motify
B8 Client Charactenstic Canfiguration (0x2902) 0x0027 w000 it

4 @ Characteristic User Defined [0x40000000000111 FLACIA0002ASDSCS1R) 00028 Motify
Client Charactenstic Configuration (0x2902) 0024 (0000 2

4 @ Service User Defined (0x00000000000FLLE19.AB40002A5D5C51B) 0x0028:
4 8 Characteristic User Defined (0x0000002000F1 1 ELACIS0002ASDSCHER) 0x002C Write w/o resp, Notify
n Client Characteristic Configuration Mﬂl] 0x002E 0000 li2
4 B service User Defined (0x00000000000EL1 E19AB4G002A505C518) D:002F

a [l Characteristic User Defined (0x00000001000ELL ELAC360002A5DSCS1B) 040030 Read, Write w/o resp, Write, Notify Ot} O
r B8 Client Charactenstic Canfiguration (0x2302) 0x0032 w000 it
,’ « [l Characteristic User Defined ((x00000002000EL LEVACIE0002AS05C51E) 0x0033 Read, Naotify 00 000

life.augmented Client Charactenstic Configuration (0x2902) 00035 (0000 2



BLE Sensor — Characteristic Update mem
(((9))) Peripheral

Connection created

Notification

aci_gatt_update_char value (ServiceHandle, 0x000C, //#wserv handle

Description Where CharHal’ldle, OXOOOD, //EnvChar handle
If notifications (or indications) are enabled Offset ’ 0x00 !
on the characteristic, this API sends a GATTserver | Length, 0x08,
notification (or indication) to the client.
Value) Data) //EnvChar Value

Lys
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Cortex-MO Sleep Management
Central (((9 ))) Peripheral

Connection created - Sleep mode managed through specific a library and API
""""""" » BlueNRG_Sleep(sleepMode, gpioWakeBitMask, gpioWakelLevelMask)

Notification
- 4 wake-up sources: timers, DIO11, DIO12 and DIO13

100 ms
- I : » Timers: 4 virtual timers mapped on 2 physical timers managed by the radio IP
* DIO12: Interrupt line from Magnetometer

Radio Active » DIO13: Interrupt line from 6-axis Accelerometer & Gyroscope

phase

r~ Deep sleep mode I
)\
‘ i {' ' T ‘

‘— Connection Intervals
> /4

life.augmented




Active mode Typical Scenarios

Tx/Rx
Low throughput l Deep sleep mode
[

v

: time
Long Connection Intervals (in the orders of secs)

"" _I_“J ..........

TX

High thkoughput

A 4

Short Connection
Intervals (min 7.5msecs)

time

Active phase
typical plot

A

RX

Start-up

|CPU |
Active CPU  cpuUOFF

XTAL RX-Z-TX Actlve ----------
startup &
LL lock

y

time

life.augmented




Low Power Modes

- Deep sleep mode can represent most of the application time.

- Efficient management of sleep mode significantly lowers the avg power
consumption.

BlueNRG-2 flexible low power architecture

High
RUNNING 1.9mA Core running ighest pwr

Low Power library combines
requests coming from the

WAKETIMER 900nA GPIOs and Timer Wakeup app'igggf;igg%tggeradio

CPU HALT 1.5mA WFI instruction

NOTIMER 500nA GPIOs only Wakeup

Lys
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Context Save/Restore

- BlueNRG-2 Low Power Library handles autonomously entering
and exiting to/from the sleep mode.

- The library saves peripherals configurations and application
context before entering deep sleep, and restores the context on
exiting from low power state:

« CPU returns to execute the next instruction after the low power function call
* No need to re-initialize peripheral and radio stack
 RAM retention is guaranteed

NO need for the application to worry about

sleep management and RAM retention!
Lys
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BlueNRG

(95
Current Consumption Estimation Tool B

* On st.com at this link:

https://www.st.com/en/embedded-software/stsw-bnrg001.html

STSW—BN RGOO1 ACTIVE = Print ‘ Save to MyST Share via Emall

BlueNRG cument consumption estimation tool

Get Software ] Download databrief

Overview Resources

The BlueNRG current consumption estimation tool can predict the current consumption under different
conditions, as defined by the Bluetooth low energy specification, for the BlueNRG and BlueNRG-MS
Bluetooth® low energy wireless network processors as well as the BlueNRG-1 and BlueNRG-2 Bluetooth®

m low energy systems-on-chip.

life.augmented



BlueNRG
| 96

Current Consumption Estimation Tool

* Accurate estimate of average current consumption and battery lifetime

&7 BlueNRG Current Consumption Estimation Tool v.1.4 (E=ar=l x|
1. Select the device [ Fie piot setings Window Help
Caloulate Consumption Performance Summary
2. Select the type of N\ B [advertang - i stive i 267ms
event W&mmm ! @ﬂm
Average current during the active phase: 49ma
Type of Device: A «| DEDC Converter Active [#]
Total average current: 7.23 uA
High Power made 4 {-2dBm)
. ._ : = Payload data rate: MA
3. Configure the HW NE:) 5.0 = CewiseipTmels) 52 [
operating conditions // Retention RAM 241@ ~|  Master SCA {ppm) [sEis0) =] Settoy Utme :
/ : Battery capacity ( =0 5
4. Configure the Intemal Low Speed Clock [[] -Slavesca (ppm) 100
. . ttery lifetime: 3 ), 3 th(s), 23 da
application use case || | VERHE- IO B TE)
5. Specify the Battery capacity 6. Read the average current and the

estimated battery lifetime

Lys
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Lab 3
LED Characteristic



£ Devices

Click the image to change the status

00000 Verizon LTE 10:39 @ 7 @} 86% mM)

M

‘1’ LED ON
‘0’ LED OFF

Notification

Packet
—

‘1’ LED ON
‘0’ LED OFF

Enable LED Toggling mem

1. Tap the image on the
screen

2. Send BLE notification
packet

3. Image changes color
and the RED LED
toggles



Code Flow mm

. Client enables LED characteristic notifications

Client Writes in Config Char

Parse write command from the client and send BLE notification
on LED status from the server



ST BlueMS Protocol

Type | "rowocol Del‘l’)'ce F:naat:lze Device MAC Len | Type | Local Name | Len  Type Pwr

BlueMS 4 Bytes

ENERERENEAEREREE
RFU

ADPCM Switch DoA ADPC MicLevel  Proximity

M NN N AN N B ox1E

Gyro Mag Pressure  Humidity = Temperat Battery 2nd Temp

Beamform AccEvent FreeFall SensFusC

nnnnn—n 0x00

r SensFus Compass Motionint Activity  Carry Pos MemsGes ProxGes Pedo

0x00

life.augmented



‘ /4

Client Enables LED Characteristic

| 101
Notifications

1. Inthe file gatt db.c goto the line 670

2. Client writes in the LED Characteristics Client Configurator Descriptor
(CCCD) and Server enables notifications through the

xFeatureNotification structure in line 673 by
xFeatureNotification.LedNotification = true;

| 670 | } else [if (attr handle — (LedCharHandle + _?)]:. 1
&7l
672 H if (att_data[0] = 01} {
673 XFeatureNotification.LedNotification = true;
674 PRINIFE ("Led ONWILE") :
675 } else if (att data[C] = C) {
676 XFeatureNotification.LedWNotification = false;
877 PRINTF("Led OFF.\n\r™):
575 = }




Client Writes in Config Char

1. Inthe file gatt db.c go to the line 806
2. Client writes in the Config Char and Server parses the command through the
function ConfigCommandParsing(att_data, data length)

l-BIZ'IE } else|if (attr_handle = ConfigCharHandle + Li i
BOT
808 f* Beceived one write command from Client on Configuration characteristic #f
809 ConfigCommandParsing{att data, data length})
810
811 - }




Parse Write Command And
Send BLE Notification on LED Status

1. Infile Sensor.c at line 1040 = lé

Check on the FeatureMask (line 1046)

If it's the LED feature mask (line 1152)
Check on the command value. If 0x01 (case1)
Turn ON LED3

Send Notification on the Config char on the
command received and parsed

o ok b

_ uint3z ConfigCommandParsin '.:Linta_t:: :
7. Send Notfficati nomeﬂa[aﬂ'zm'ﬂm#\e: ELETINE | (et

1042 uintZ t Command = att data[<]:
LED Statugj-?f. uintZ t Data = att_data[=]:
1044 uint32 t SendItBack = 1;

10
j [switc'.h (FeatureMask) ]

Lys
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1154
1155

1158

1160

case FEATURE MASK LED:

aK, valLean:LEDl}a

PRINIE (LoD e, LED\n\z");

Config Notify (FEATURE MASE LED, Command, Da@h}
break;

case O:
S5dkEwvallLedCff (LED1) ;
PRINTF ("Di=abled: LEDYn'x");
Config Wotify (FEATURE MASK LED, Command, Data)
break:
i

[ if :xFeatuIeNotification.LedNDtificatiDn}]{

it LEDL) )
Led Update (ENABLE)

else
Led Update (DISABLE) ;

break;



Lys
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“Switch”

Click on

T

£ Devices

0.00 mBar

14:12 @ 7 % 72% W
U
Not Present
52.40%
O i

Enabling LED Toggling

A new page will appear

< Devices

Click the image to change the status

o000 Verizon T 14:15 @ 7 % 71% )

(7




Enable LED Toggling

00000 Verizon LTE 10:39 @ 7 0 3} 86% =)

£ Devices m

Click the image to change the status @

Write
Packet

‘1’ LED ON
‘0’ LED OFF

Notification

& 1. Tap the image on the screen

1"LED ON 2. Send BLE notification packet

& w & O - ‘O’ LED OFF
3. Image changes color and RED LED
toggles



LED Fast Blinking Due to Sleep Mode

* Red LED fast toggling shows the entering/exiting to/from Sleep mode

Connection Intervals

0 o

V) Y |

1

In Active Phase In Sleep Phase
LED is ON LED is OFF

Deep sleep mode

1

life.augmented



« String “LED Notification ON” will appear as the app tab is enabled

« Each time user click on the LED icon in the BLE Sensor app, the
Write command is sent to the board and the LED toggles
accordingly (“Enabled: RGB led” = ON, “Disabled: RGB led” = OFF)

fDevice iz now discoverable with MAG: 3f:Z2c:f6:eb:da:d8
Sensor activated: 0K
Device connected

Environmental Motification ON
nuiranmental Matifdication OFF




Lab 4

Accelerometer Embedded Events Detection

life.augmented



Example - Single Tap

1. On the board perf
(@) Single Tap

2. Send BLE notification

Notification packet

Packet
—

‘SINGLE TAP’

NOTE: this is just an example
for SingleTap. Other events will
be displayed later in the lab!



4 Bytes ST BlueMS Protocol

Type F:,g;gﬁl De,‘gce F,?nzt:;e Device MAC Len | Type | Local Name | Len Type = Pwr

BlueMS

o EEENERNER .

ADPCM SW|tch DoA ADPC MicLevel  Proximity

npqmnn 0xoE
Gyro

Pressure  Humidity = Temperat Battery 2nd Temp

0x04

RFU

7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 [N

SensFus Compass Motionint Activity  Carry Pos MemsGes ProxGes Pedo

Beamform| AccEvent FreeFall SensFusC

Lys
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-
& - L SM6EDSO at a Glance

\ 1. PERFORMANCE AND FEATURE ’ \2. FLEXIBILITY: algorithm @ silicon level ’
* Accuracy: Tango and Daydream compliance ... - ;
« 0.55mA current consumption is HP combo ~@—

-15% vs. LSM6DSL/M @ same performance

* Pedometer 2.x
WeChat Precision

e
- New Ultra low power mode: LSM6DSO — |
14 A @1 OOH ODR A I I — o FSM build custom
u ( = ) Xl on y sensors for XL and
o m}-— Gyro
|h
 4.INNOVATION |
2.5x3x0.86 mm .
« MEMS: Axl T-structure for mechanical
R shock robustness
B - Compressed FIFO (3x)
* FIFO tag » 10 patents protecting LSM6DSO

innovation



Client Enables Accelerometer Events
Characteristic Notifications

1. Inthe file gatt_db.c go to the line 703

2. Client writes in the Acc Event Characteristic Client Configurator Descriptor
(CCCD) and Server enables notifications through the xFeatureNotification
structure in line 714 by xFeatureNotification.AccEventNotification = true

} elsg if (attr handle == (AccEventCharHandle + 2))} {

L Bl if (®xFeatureNotification.MotionMotification == false && XFeatureNotification.iNemoEngineMNotification == false) {
707 9 pip TR = SR RS R
T08 lsmédso x1 data rate set (0, L5M6DS0 XL ODR 52Hz) ;
709 m:uul,urj.u_r;n_r, BTC DESRLT: 77 fronimrcy OFF
710 EnableHWMultipleEvents() s
- > () =
711 GPIO EXTICmd(GPIO Pin 13, ENABLE);
T1z2 Config MWotlfy (FEATURE MASK ACC EVENTS, 'm", 1);
-?r_a et _“ ity
- lxFeatureNutificatinn.AccEventhtificatinn = true;
14 PRINIE (TLCCEVENT NOLLLICOCION CHAnnEIT) .
T15
T16 } else if (act_data[d] == 0) {
== l=zméd=soc x1l data rate set (0, LSMeDS0 XL ODR OFF);
‘ '__" xFeatureNotification.AccEventNotification = false;
’I 1o GPICO EXTICmd (GPIC Pin 13, DISABLE);

life.augmented



1300
1301

1334
L35S
1336 =

1337
1238
1235
1240
1241 =

1342 i
1243

Lys
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rlzaa [Fvoid MEMSCallback(vpid) {

f* Check if the interrupt is due to S5ingle Tap */

i dwareFeaturePFresence.MultipleEvent) {
if (all =zource.reg.all int src.=single tap)

if

SdkEvalledOn (LEDL) :

SdkEvalledCn (LED3) -

PRINTF("Event: Single Tap'ohr™) s
AccEvent Notify (ACC SINGLE TAP, 2)

lsméd=so all sources get i-: » &all source);

Read Event Status and

Send BLE Notification

In the file sensor.c

1.

line 1299 void MEMSCallback(void)

Callback triggered by 1013

line 1301 Ism6dso_all_sources_get

Read accelerometer status registers

line 1336 if (all_source.reg.all_int_src.single_tap)
Check vs. single tap event

line 1340 AccEvent_Notify

Send BLE notification



\\
~

b ~
~

27.60°C

NS

1024.14 mBar
L
Enviromantal

@ 79} 77% m-)

<\

Not Present

g

Not Present

-

0

Select

Visualize Single Tap Event

“Acc Event”

1
1
1
1
1
1
1

~
~
~
~
~
~
~
~
~
~
~
~
~
~
~
~
~
~
~
~
~
S
~

in ST BLE Sensor

Select
Tap “Single Tap’ Enabled

“Event Enabled” and hit‘Select”  «Single Tap’

o 6:53PM 7§ on e wavoe Vorizon = 1021 @ 7§ son 1 @ 7% a5

{ Deviceg il Select the event to detect < Devices ]

Event Enabled: Single Tap

Event Enabled: Wake Up

= Single Tap
wake Up

e

Select

q - wall g :” Cancel “ = [+ = s
. i ' SAChR/ Rl More Eonrgmanta ok JLoguan_ AccEemt P Batiory

»

Enviromental

oing Acc Event




Event Detection

1. On the board perform a
Single Tap
2. Send BLE notification

packet
(@)

Notification
Packet

—
‘SINGLE TAP’

Single Tap

( vice! [ 1

& @& O R )




Tera Term Output

-

- “AccEvent Notification ON”: - s ot it
File Edit Setup Contrgl Window Help

enable notifications on the .
. . ccEvent Motification OFF
Accelerometer Event characteristic [T EESICLEY,

e W
LYl = LFLF WAE” J.Elll.rtl.l.rl.l.lll

- “Enabled Single Tap Detection”: R R Nt

user enables Single Tap event Jeuent: Bingle Tan
. vent: 5ingle Tap
detection Fvent: Single Tap

« “Event: Single Tap”: the actual
BLE notification packet is sent
upon detection of the Single Tap
event.

‘1’ NOTE: if the phone display enters sleep mode, the notifications are not sent

ie.augmented



LSM6DSO Embedded Events

Other possible
embedded events

No event Free fall Single tap

®| L] N

Free Fall
Single Tap Wake up Tilt Pedometer
Double Tap =T T T T e T T S i

s | ¢
sssss LY G

CCCCCC

WakeUp
example




Visualize Hardware Wakeup Event
in BLE Sensor

sssco TIM 2 6:53 PM 7 95% .

- vices T
£ = Select She =
~ i F [Evenl Enabled: Wake U;)]

“Acc Event”

27.60 °C Not Present

< &

1024.14 mBar Not Present

¥ G O] = |
Erviromantal Flot Datas Cloud Logg Ace Event Mara

~
~
] Sso
~
1 S
1 SN
~
1 S
/ S~
~
1 S~
S
! ~

* u“J o ._* .00 £ “ ‘ .i. .a‘r?‘,m v.x::

Emviromental Blot Data Cleud Logning: UASE EvVent




Event Detection

1. Leave the board still for a few seconds
2. Shake the board
3. Send BLE notification packet

Wake Up

7§ 06% m.
0

£ Devices il

(@)

Notification
Packet

—
‘WAKE UP’

# » & J -




W COMEL - Tera Term VT

 “AccEvent Notification ON”’: enable
notifications on the Accelerometer Event

CharaCteriStiC Fuvent-=: bl Urientation
. “Enabled Hardware Wakeup”: user Fromrods fasduane ekons | Cootion
enable hardware wakeup event detection  Hdeare Daaeur
. “Event: Hardware Wakeup”: the actual : Navduore Wokoun
BLE notification packet sent upon e
detection of the Hardware Wakeup event. e

HccEvent Motification OFF

Lys
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LSM6DSO Embedded Events

You can go ahead later and test other events...

Other possible Noevent  Freefal  Single tap
embedded events e e

® LN

W & @ - -

7 3} 95% -

Select the event to detect

- v

Double Tap

Wake Up

Pedometer

£ Duvices

B L

Cancel ‘5)




Lab 5

9-axis Acc+Gyro+Mag Sensor Data Fusion

life.augmented



Goal

* In this example we are going to demonstrate how to:

« Enable the embedded sensor data fusion library

* Input: raw Acc+Gyro+Mag sensor data
« Qutput: quaternions

» Scale the quaternions value by a scaling factor proportional to proximity
detection

« Send scaled data fusion information through BLE notifications packets
to the ST BLE Sensor app client

gmented



§
Ed)

Sensor Data Fusion

(®)

Notification 0,
.rs

= S 3

“'". y
ex( )
\ BN y
..\- -
\-.}'_H_: {

Sensors used by data fusion:
Acc+Gyro+Mag and Proximity

y -~
- (S )

- . E# C4
1 - > -

\ 7

| r J

&mﬂ -
j

. Enable Sensor Fusion

library

. Send quaternions

information through BLE
notification packet




Code Modifications

. Enable Sensor Data fusion library

Enable proximity sensor

Send quaternions data — scaled by proximity sensor data -
through BLE notifications packets



4 Bytes ST BlueMS Protocol

Type F:,frt;gﬁ' Del‘l')'ce F:nzt:;e Device MAC Len | Type | Local Name | Len  Type Pwr

ADPCM| Switch ’ ADPC Mchevel‘ Proximity Lux

npqmnn OxFE
Gyro

BlueMS

0x22

Pressure  Humidity = Temperat Battery 2nd Temp

mnmm 10 3 | R

Beamform| AccEvent FreeFall | SensFusC

4 3 | 2 | 1|0 .

SensFus Compass MotionInt Activity  Carry Pos MemsGes ProxGes Pedo

uugmemed



Sensor Data Fusion
L1 2 ®

Swipe left to view the “Mems Sensor Click on Sensor Fusion
Mems Sensor Fusion Fusion” tab OK enabled
wec00 Verizon U 10:42 & ec00n Vorizon (TE 10:39 T 7o een - ‘ e 10:40 @

C

LEEES 1

-
‘— To calibrate, move the board as
‘ shown in the image k
—-—
age

\

1013.73 mBar 51.50 %

# w G o - o e @ O o W o aw O -




Proximity Sensor
@ L2

Enable Proximity Far from Near to
_Sensor BlueTile BlueTile

86% W #0000 @ 7 @ % 56% MM

£ Devices ] £ Devices

% -

Move your

hand far and

close to the
BlueNRG-Tile

©Proxin Ve _ P .
; ot .,..wg.!.w., -. 0 . » - wai [+
0 @

Note: ONLY for rendering purposes, the cube is scaled
proportional to a clipped 30 cm distance




Proximity Sensor - VL53L1X

3rd gen ToF sensor with lens for long distance ranging & ROI selection

N

Product highlights

OLGA:4.9x25x1.56 mm
FoV : 27°
Compatible footprint with VL53L0X

Enhanced performances:

* Full FoV ranging : 400cm+ (white target, no IR)
*  Programmable FOV: SPAD zone selection — full-screen to 4x4

Cutting-edge module and silicon :
» Fastest miniature ToF product in the market up to 50Hz

* Integrated lens for longer range and better ambient light immunity
* Programmable settings to best fit customer’s application:

» Low power with interrupts for user / object detection
» Long distance ranging
+ High accuracy for small movement detection

N

4 N

Applications

Presence user detection

* Autonomous mode with interrupts

* Low-power

* Long distance 400cm+

« PG, tablets, 10T, portable handsets, security

Obstacle detection:

» Robots: Obstacle avoidance

» Vacuum cleaners: Wall following, cliff detection
» Drones: Take-off and landing, Ceiling detection

Accurate objects distance scanning
* Vending machines: control of objects in racks
» Coins dispensers: coins counting

« Smart shelves: Consumer scanning

Lys
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Full-range Proximity R
@

“Plot Feature”
tab

Swipe left to view the
real-time data plot

Select
Proximity

eal-time Data Plot
O] L3 O

Selectthe  View the
time frame real-time

data plot

[ 5% - 920V o} 71 wei Vel E 00: 7% 95 m.: ek E]
. T
{be 0 <pe [ Select the feature to plot elect the t T ~
H
§
oy Accelerome ‘ e
3 1 P 5 = §
5 | Proximity S 3
I —r—F——7— 1
i g1
I
I
)i
gl
X
|
? llllllllllllllllllllllllllllllll
g 2 & 1 B
B - & H s B Proximity (mm)
e ( 0 - ¢+t et |\  Select Ts:64308 Proximity:104
# % @ o - # @ o « w| [ e # w @ o
W S Fun £ L Er il Meern Seescr i




Logging Real-time Data Plot
o i o o

_ After some time
Click on Select re-click on the Select App opens your

top right corner “Start 10gging” (ight-top corner “Stop logging”  email client

®secc Verizon LTE 09:37 & 4 3 957% m- T eseco Verizon LTE 09:37 @ o} o5% M. #0000 Verizon LTE 14:28 @ 7o % E8%m
{ Devices mJ/ | | { Devices [ﬂ Cancel [ST BlueMS] Logger data
Stop plotting Accelerometer Stop plotting Accelerometer
g g CeiBee
Subject. [ST BlueMS] Logger data
§ |
H
]
20180319.1..romets

Start Logging Stop Logging

[EMETTS
P

Show Debug Console Show Debug Console

License Manager License Manager

Firmware Upgrade i%«*%k»:—' 4—;—~+H4E Firmware Upgrade
g g
X

— =

Settings Settings
Ts:44136 X: 269.00 (mg) Y: 220.00 (mg) Z:

-695.00 (mg)

Ts:44136 X: 269,00 (mg) Y: 220.00 (mg) Z:
-695.00 (mg)

# &0 - m

Cancel Cancel

e/

‘W .csv files attached
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Sensor Data Fusion

sensarfusion  Try static position: no drift, the cube is perfectly still

enabled

==+ |n steady static position the acc and mag enable an accurate orientation
estimate
- N|  ° acc vibrations and mag bias and interferences are rejected or

compensated by the motionFX library

Try highly dynamic motion: perfect tracking
In high dynamic motion the acc cannot be used, therefore the gyro is used to
update the orientation

=« gyro bias is estimated and compensated at runtime by the

; motionFX library

o}
3
=,
a



»
Magnetometer »

=3~

Roll, Pitch

MotionFX Quaternion

Heading

Sensor

Fusion Gravity Vector

33333

Linear Acceleration

Sensor Data Fusion
MotionFX Library

E S User
] BlueNRGL it.c
@ ] gatt.dbic
[H I_j SEnsOr.C
# [ﬂ SenzorDemo_rnain.c
® ] HWadvanceFeatures.c
WA Hal
= 3 Stack
] libbluenrgl_stack.as
E-@] stack_user.cfg.c
] liberyptaa
@ I OTA
o wEsslix
= L MotionFx
L] MotionF100_CMOP. Keil_otilib

= | BlueNRGL_BlueVoice Library
'] bluevoiceADPCM _BNRGL_100_Keillib



Sensor Data Fusion

MotionFX Library

» Roll, Pitch

MotionFX [ 2

=

= W
=

- Accelerometer gives roll and pitch angles and the gravity
vector...but only in static conditions! (or low dynamics)

Lys
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Accelerometer »

=

Sensor
Fusion




Sensor Data Fusion

MotionFX Library

Yaw

=

Accelerometer »

MotionFX |[_Z

- BT
=

Magnetometer »

=

Sensor
Fusion

=

- Magnetometer gives yaw angle and heading
...but only if tilt is compensated: the accelerometer is needed!
...and magq bias (hard-iron) must be compensated!

Lys

life.augmented




Sensor Data Fusion
MotionFX Library

=y Fol Pich | Yaw
= B
= "

= R
| orosene g o2 Focoraion

- Gyroscope gives the new orientation based on previous orientation
...but gyro bias offset needs to be compensated for accuracy!

Lys
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| 136

=

MotionFX

Sensor
Fusion




»

=3~

Sensor Data Fusion
MotionFX Library

=Y Roll, Pitch
MotionFX [ 4  Quatemion [

Fusion » Gravity Vector
» Linear Acceleration

Motion FX library provides orientation estimation plus:

Magnetometer hard-iron offset compensation.
Accelerometer vibrations rejection.
Gyroscope bias offset compensation.

< Devicss

-

= - - O




The gyroscope is the most important sensor in the system
...works in highly dynamic conditions when the Acc cannot be used GerSCO pe

...works with magnetic anomalies when the Mag cannot be used

‘—, T2 LSM6DSO
LSM6DSO is an inertial module with Acc and Gyro oo e e e
- Exceptional noise performance for maximum SE .|
. . . " " (25 %3 x 083 my 00 The LSMEDSO Is a system-n-package faturing a 30
accuracy In orientation estimation — e o e
90 ug/sqrtHz acc noise density . PvommmosmnGro,  Telcoupmrmoonuws
3.8 mdps/sqrtHz gyro noise density R T
E %ﬂﬁlqgmmmm %:“Mﬁ%m
- Extremely low-power ¢ g sy e 1713 SR s o s b i e
* 650 uA peak power at ODR 6.66kS/sec with i — ST
Acc+Gyro in high performance mode! | T sy wepore 25 s g
o e T
e e o
= mmmw LSMEDSO Is avaliable In 3 plasticland gnd amay (LGA)
+ Embedded temperature sansor package.
+ ECOPACK®, RoHS and "Green" compilant Table 1. Device summary

Lys
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LIS2MDL is digital Mag

- Exceptional noise performance and
dynamic range for maximum accuracy in
orientation estimation

« 50 Gauss dynamic range
« 3 mgauss RMS noise

« Embedded offset compensation
* Intrinsic offset is estimated and compensated
automatically
« Extrinsic offset (hard-iron) must be estimated by
host and can be compensated internally

Lys
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Magnetometer

r LISZMDL
’I o .augmented

Digital output magnetic sensor:
ultra-low-power, high-performance 3-axis magnetometer

Datashest - production data

Description

The LIS2MDL is an ultra-low-power, high-
performance 3-axis digtal magnetic sensor.
The LIS2MDL has a magnetic fiedd dynamic
range of £50 gauss.

The LIS2MDL includes an FC serial bus interface

LGA-12 2.052.0x0.7 mm) Pris e et

plus, and high-speed (100 kiHz, 400 kHz.
1 MHz, and 3.4 MHz) and an SP1 serial standard

Features interface.

= 3 magnetic field channels mdevucanbeomﬁguredtomm

« 50 gauss magnetic dynamic range pt signal for magnetic field L

« 18-bit data output The LIS2MDL is available in a plastic land grid

5 5 . amay package (LGA) and is guaranteed to
SPINAC serial interfaces AT e

« Analog supply voltage 1.71 Vio 3.8V from <40 *C to +85 °C.

« Selectable power mode/resolution .

« Single measurement mode Table 1. Device summary

* Prog ble interrupt generat patnumber | T®MP- | package |Packaging

range [*C]

= Ewbeaied wetant LIS2MDL 20to+85 | Lea-12| T

« Embedded temperature sensor = 3 =,

« ECOPACK®, RoHS and "Green” compliant LS2MOLTR | 40tos8s | LGA-12 7"::“

Applications

« Tilt-compensated compasses

« Map rotation

= Intefigent power saving for handheld devices
= Gaming and virtual reality input devices




Magnetometer

Calibrati
#0000 Verizon LTE 0:4 % B6% m- e0000 Verizon (TE 10:39 & 7 0 3 B6y mm sacon Verizon LTE 12:28 @ 7 9% 70% ML
CDwvices M C Davicen ' < Devices ]

Move the BlueTile with the “8

pattern” shown in the figure to
calibrate the magnetometer

Calibration is Completed
when the icon becomes green.




'erizon 35 .
£ Devices m
= Acc
i switeh
@ compass
i} R

Magnetometer ECompass

wesc verizon UE 1520 & 7 9% a3n M0
£ Devices [Tj
= Acc Event
B sw
@ co ]

il Rssi & Battery

# & @ o -

Select
“Compass”

the current orientation
of the BlueTile

Rotate the BlueTile

(you can check against the

phone eCompass)



Lab 6
Cloud Data Logging on IBM Watson
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Cloud Logging

1. Enable IBM Watson loT — Cloud Logging
2. Send BLE notification packets on Sensor status
3. Visualize the data

Ijom||
' |
I
ul
||||

\ |||

IBM Watson

& (@

#0000 V. = @ 7 3 84% mm>
< Devices M
Select the cloud provider

IBM Watson loT - Quickstart
IBM Watsaon loT
Azure loT - ST Web Dashboard
Azure loT
Generic MQTT
Aws loT
-~ = o - 1111H]
Cloud Logaing

(@)

Notification
Packets




IBM Watson loT Quickstart

2. Select “IBM Watson 1. Selectoneor —
loT - Quickstart” Click “Connect” multiple features Wait a few seconds

0000 Verizon 5 10:50 @ 7 3 84y . wee00 Verizon LTE 15:46 @ 7 O} 60% > eee00 Verizon LTE 15:51 @ v 9} 60% 0000 Verizon = 10:52 @ 7 % 83
< Devices ﬁ < Back IBM Watson IoT - Quickstart < Back IBM Watson loT - Quickstart < Back Cloud Data
Device Id Device Id
: BCN-034_571EBF BCN-034_671EBF
Select the cloud provider S

IBM Watson loT - Quickstart [ Connect ] Disconnect

IBM Watson loT Battery

Azure 10T - ST Web Dashboard [ Temperature O ]4—

Azure loT Humidity

P y 2
Generic MQTT ressure i &

Aws loT [ Accelerometer c ]4—

1. select “Cloud
Logging”

[ View Data on Cloud ]4

k

& &l & |~ m S = m & O = W

ai0j)  Cloud Logaing hee Even Rssi & Batter nviromental 1 Data  Cloud Logging scc Event  Rsel & Batter

*« .‘ O =N LI

i Cloud Logging  AccE tData  Cloud Logging  Acc Event  Rssi& Batt

2. Click “View Data
on Cloud”




IBM Watson loT Quickstart

Quickstart will You will see the Plot  Table of available
appear of selected feature features

eecco Verizon LTE 16:54 @ 7 p 72% . #c000 Verizon LTE 16:54 @ 1 72y - e0000 Verizon & 10:52 @ T % 83% mm) o000 Verizon LTE 16:55 @ 7% 71% ..y
< Back Cloud Data < Back Cloud Data { Back Cloud Data £ Back Cloud Data
— Blue034 C3BEDS s ue034 C3BEDS
IBM Watson loT Platform = EehY L OeHE | ' . | Buc034 comer
® Last message received at 4:54:57 PM e ® |_ast message received at 4:55:22 PM
BQui ‘
Quickstart u
No sign-up required to see how easy it is to connect Blue034_C3BEDS Accelerometer.Z L 2 Blue034 C3BED5 Temperature.Temperature
your device to Watson IoT Platform and view live 19522 Tofen tomadt
sensor data
7 Event Datapoint Value 7
Blue034_C! 5 3 w0 289 4 =
400 Accelerometer z -1021 — V.
® Last message received at 4:54:31 PM 200+ /
S c ro I I d OW n 04 Accelerometer Y 12 287 - f '
200 : 286 [ \
‘to See your o f\'/l Accelerometer Timestamp 67589
285 ] \
Biue034 C3BED5 AccelerometerZ S e I eC te d P GRS X 3 |
28.4 - -
-800 < /f‘ ‘
Se n SO r p | O t 1000 vy \\/ Temperature Timestamp 67600 2834 /
Bl Temperature Temperature 292 W2ttt
40 -1400 T LLE | T ™1 117 T 1T n T
16:54:40 16:54:46 16:54:53 |5:55;n&| T ;5:5‘5:1; T ||5:5|5‘1I5 o
500
I've seen my data, what next?
600
= Event Datapoint Value - . P Event Datapoint Value
# & O = W # & O = ¥ & O = w # & O = mw
Envicomental  Plot Data  Cloud Logaing  Acc Event  Rssi & Battary virementa ot Data  Cloud Lopging  Acc Event  Rssl & Batter Enviranantal fot Datn  Cloud Logging  Acc Event  Rssl & Battery Envirementa PlatDate  Cloud Logging Even

Scroll down again to
change sensor data or axes



Lab 7

Voice over BLE
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Goal

* In this example we are going to demonstrate how to:

- Enable the BlueVoice library for Voice Over BLE
streaming

* Input: raw data from the MEMS microphone
 Output: ADPCM data streaming @8kHz

 Send ADPCM data through BLE notifications packets to
the ST BLE Sensor app

Lys
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ecoco Verizon LTE 10:42

£ Devices m

® 7 0% 72% W)

¥

Sampling freq: 8 kHz

Volume:
Beam Forming:

bbby — iy

: 8
¢
&

BlueVoice Library

1. Enable BlueVoice library

2. Send voice to the ST BLE Sensor app client
through BLE notification packet

(@)

B
Notification g
Packet | ( ( !
—
ADPCM
compressed audio MEMS
Microphone



BlueMS 4 Bytes

Type F:,g;gﬁl De,‘gce F,?nzt:;e Device MAC Len | Type | Local Name | Len Type = Pwr

Switch ’ ‘ ADPC IMcheveI‘ Proximity | Lux

“ﬂ“ﬂ“ﬂ oxFE

Gyro Pressure  Humidity = Temperat Battery 2nd Temp

mnnm 10 3| E.

Beamform| AccEvent FreeFall | SensFusC

4 | 3 | 2 | 10 PN

SensFus Compass MotionInt Activity  Carry Pos MemsGes ProxGes Pedo

Ox6A
RFU

life. uugmenfed

ST BlueMS Protocol



Enable BlueVoice Library
Add the preprocessor symbol ENABLE AUDIO to the project

1. Right-click on Release
2. Select “Options for Target ‘Release’...”

KA CABlueNRG _Tile_HandsOn\STEVAL-BCNOD2VA DK 3.0.0\BlueNRG-
(File Edit View Project Flash Debug Peripherals  Tools
B9 -je-[nER

[= | -Hﬂ-| Release D |&| ﬁ
-3

jr—

EI Tﬁ Project: BLE_SensorDlemno
= 42 Re

- s~ Dptions for Target Release’.., Ait=F7

ol .ﬁ.dd Graup...
i
s | ‘1 MWanage Project ems,.,
2 Open Map File
£ ‘Cpen Bulld Log
@ | (25 Rebuild all target files
W L 5] Build Target 7

_L.

- : | —
I: L-|\"r | Show Include File Dependencies



Enable BlueVoice Library

In the project options:
1. Go to the tab C/C++ and then in the Preprocessor Symbols

2. Set the symbol ENABLE AUDIO=1 and then click on OK

{2 Options for Target Relesse T =
Device | Targst | Outpit | umﬂwl EC+ |'\n:|1 | Linker | Debug | Liities |
- Preprocessor Symbols
Define: [=SMPS_INDUCTOR_10uH SEND_N_QUATERNIONS=1 ADC_2411=1 DEBUG:‘[IEEE!M![I}IE '
Unidefire: |
i
| | Lsngusge / Code Generstion
' | I BecuteonlyCade [ Sinct ANSIC VWemirigs:
|:| Optimization: [Level 3103 ) ™ Enum Container slwaysnt [AlWamrgs 7]
) ¥ Optimize for Time [ Plain Charis Signed [T Tt dinds
i I Splt Load and Store Multiple: [ ReadOrly Position Independent [ Mo Aute Includes
|;| ¥ G ELF Section pér Finctian ™ ReadWrits Position Iidependert. [ C39 Mods
I’I N
f h;ﬁg [W 3o U A brany BusNAG1_Pengh_Diverine; .\ .\ \Lbrary\CMISIS Devics S T\ __ |
|
| ~ Mise
Controls
Cempiler |38 ¢ —<pu Cortex-M0 g 02 Ofime —spcs=nterwork —split_sections | ./ /inc - - |
w S /4, ey /BlueNRG 1 Periph_Diver/ns - |
g | - -
, I ok || Canee Defaults. Help
life.augmented l —J




BlueVoice: Voice over Bluetooth LE

Select Speak close to .
“BlueVoice” the BlueNRG-Tile
- i .« B — B (( {
o = v MEMS
*-: SpeechToText *-? SpeechToText ;‘::J:lj;rming: e Microphone
o Compass o Compass
(- WD i & atery (if the mic captures the audio from
Oy the phone speaker, a very high
pitch sound can happen!)
Voice will be streamed over BLE
) ) You will hear it from the phone
g v a0 g .2 a0 e — ——
Tap oo Do not silence your phone,
Niie must NOT be vibration only!

Lys
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Voice over Bluetooth LE
.................... B

" Generic Attribute ]‘ Generic Access ‘ “ . . |t,S d VendOI‘ SpeCifiC
B GAP configuration

Profile (GATT) Profile (GAP) .
( Service!
Central (ea Peripheral
(Master) (Slave)

GATT configuration

Attribute Protocol I Security Manager

Logical Link Control and Adaptation Protocol

Audio: exported by the Server

© m through 2 dedicated BLE

. characteristics

Bluetooth Low Energy Stack j Characteristic Voice Stre.ammg over BLE:
Audio @8kHz

e Codec: ADPCM
1 — | Bitrate: 32kbps

Link Layer I Direct Test Mode

Physical Layer

1

|

I

i

|
Host-Controller Interface i
7 I
I

|

|

]

i o o o T o o o S o o

Lys

life.augmented



“H'l;

BlueVoice ADPCM - Aud.io 8kHz

Central (((e3 ))) Peripheral

Advertise

Advertisement Mode

Discovery Mode Advertise

Connect Request

No acknowledge required for Notifications:

) . Connection created .
«  OK for Audio streaming g — i B Perivheral-to- Audio can be
.. : Notification eriphera to
* Minimal Latency — Central half-duplex
+ Optimal Bandwidth communication
I I Connection Connection Connection Connection Connection
VOICe Streamlng Event Event Event Event Event 2 k t / t
« Audio Format: PCM 16 bit @ 8 kHz S N N S s packets/even
. ADPCM Compression @ 32 Kbps: | | ... ... 20 bytes/packets
Low latency and low complexity Radio 100 events/sec
« Side Information at low data rate ! e 8 > _
enhances error resilience 10ms 160ms t —
Connection interval ADPCM Synch interval 32kb

I Audio Data Packet, 20 bytes N Sync Data Packet, 6 bytes




BlueVoice Architecture

“Packetization” 5 User

] BlueNRGL _ite
@ ] gatt.dhb.e

BlueNRG-2 Hi] sensorc

@ |1 SencorDemo_main.c

ST digital MEMS
microphone

ExE Q HWadvanceFeatures.c
. PDM PCM -- Raw Data er . -l
Audio PDM to PCM - ADPCM »| Server-TX & Stack
Acquisition conversion 6KkHz > Compression GBBluetoggrl L] libbluenrgl_stack.a
‘ l - E | stack_user cfg.c
— |1 liberypto.a
\ B O VIS3LIX
Bitrate 32 kbps = =3 MotionFY
| 1 MiotionEi00 CMOP Esil ol
o el 66 = = 59 i Suegfilf:::;c; LBi:;gl 100 _Keillib
L De-Packetization S
Smartphone app (ST BLE Sensor app) &
ient - . Serial Audio
‘_J Client - RX Raw Data Audio PCM N
€3 Bluetooth > Decompression » USB. 125 — )
SMART y y nun

i

life.augmented



Lab 8
Over-The-Air (OTA) FW Upgrade
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0x1007E800
Empt
o OTA
0x1005F800 BLE_Chat_Server_HigherApp_OTA.bin
BLE_SensorDemo_ (((ea )))
LowerApp_OTA
0x10040800

BLE OTA_ResetManager

0x10040000

r REMEMBER TO LOAD THE BLE OTA Reset manager!!!

life.augmented



0x1007E800

0x1005F800

0x10040800

0x10040000

BLE Chat Server
HigherApp_ OTA

Empty

BLE OTA_ResetManager

Once OTA is Completed...



OTA FW Upgrade (1/2) ==

Click on the top right Select “Firmware Select your remote Select the binary file

” .
corner Upgrade repository
Wil TIM & 16:29 B 23%0 Wl TIM = 16:33 % 23%@
Browse Cancel £ Locations Tile_DK1.1 Cancel
Q, Search Q Search

Locations Sorted by Name ¥

& iCloud Drive @

£
@
&. Google Drive i i

—
&
»

9 Dropbox — Personal BLE Beacon U BLE Beacon U BLE Chat Serv
25.20°C Not Present
se_OT..anager se_OT..anager er_Hig...pp_OTA
3/2619 3/2610 3/2619
Start Logging B Recsiity mlstad 230 KB 82K8 78 K8
. ® @ @
Show Debug Console Favorites

BLE_Chat_Serv  BLE_Chat_Serv BLE_Chat_Serv
® Red er_Hig...pp_OTA er_Low..p_ OTA er_Low..p_OTA
Settings 3/26/19 3j26/19

214 KB 76 KB
@ Orange

P @
Yellow

- w o e Cancel Green
Mems SensorFusion Plot Data Ace Event More °
r Recents 0

life.augmented

@ l 5 4 ' Firmware Upgrade Tags

996.01 mBar 4710 %

License Manager




OTA FW Upgrade (2/2)

OTA data transfer Click OK as
begins completed
7 e | o
Version: 1.0‘OBLUENRG o ® 8%32'«?3215502—3;759 BlueTile nOW runnin
Mcu type: BLUENRG - — ’ . . g
PM1V100 - a new application

C0:6E:33:38:36:30
Flashing the new firmware

2048/75984 bytes

Upgrade completed

The board is resetting

' Ok l

Lys
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Customizing Your Design



STEVAL-BCN002V1B Block Diagram

Matching
Network’

BALF-NRG-02D3

Integrated balun

UART RXline

IRQ ADC
LIS2MDL BlueNRG-2 RGB LED
magnetometer Bluetooth 5.0 Network and

12C
LPS22HH 5C Application processor MP34DT05-A

barometer microphone

HTS221 kHz
Relative Humidity & Temp. 12C connector

LSM6DSO 12C
accelerometer + gyroscope

VL53L1 e
time-of-flight proximity

Lys
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Enable/Disable Sensors & Libraries
- Dedicated structure “FeaturePresence’ for
enabling/disabling sensors & libraries individually. File sensor.h

typedef struct {
bool AccelerometerGyroscopePresence;
bool MagnetometerPresence;
bool HumiditvTemperaturePresence;
bool PressurePresence;
bool ProximityLightPresence;
bool iNemoEngine:
bool Pedometer;
} FeaturePresence;

- SensorScan() function set each field of the structure to false or

t F'I /{ Check sensor list
rue. rile Sensor.Cc Sensorssoan();
// Configure discovere d sensors

if (xFeaturePresence.PressurePresence)
Init_Pressure Temperature Sensor();
. if (xFeaturePresence.HumidityTemperaturePresence)
Disable the unneeded toss_pamsaiey Sensor ()
if (xFeaturePresence.MagnetometerPresence)
. . . Init_ Magnetometer():
SenSOr for Optl m IZI ng the if (xFeaturePresence.lAccelerometerGyroscopePresence)
Init_ Rccelerometer Gyroscope ()
if (xFeaturePresence.ProximityLightPrezence)

m power consu mptiOn ! Init Proximity Sensor():

f/ Configure sensors in low power mode
lite.augmented SensorsLowPower () !



BLE Timings

- Advertising intervals:

» Dedicated APl aci_gap_set_discoverable(Advertising Type,
Advertising_Interval _Min, Advertising Interval _Max, ...)

« In file sensor.c
« Connection intervals:

« Dictated by the Central device. Peripheral has no full control on this.

- Notifications frequency

» Dedicated Virtual Timers (mapped on HW physical timers) for different
functionalities

« Timeouts defined in sensor.h

#define BATTERY UPDATE RATE 1000 // Fixed ODR € 1 Hz
:— #define ENV_SENSCR_UFDATE RATE 100 // Fixed ODR @ 10 Hz
, #define MOTION SENSCOR UPDATE RATE 40 // Fixed ODR @ 25 Hz
life.augmented



HW Modifications

* In this case redesign is of course necessary

- Schematics and Gerbers files:
* online at www.st.com/bluetile 3.12.2 Functional description

The table below shows the GPIO configuration table where each 10 pin is associated with related functions._

u n
¢ BI N G'2 a Table 129. 10 functional ma
ueNR iInm INn b p
GPIO mode "000™ Serial1 mode "001" Serial0 mode *100" Serial2 mode "101"

« Check BlueNRG-2 DS at Table 129 Fn e | | Signal | Type | signal | Type |  Signal

100 Vo GPIO D i UART CTS | 1O SPI LK 0 CPUCLK
101 1o GPIO 1 ) UART RTS | 1D SPI_CS1 | PDM_DATA
102 | wo | ero2z | o | pPwMo | © | sPLouT O | PDMCLK
103 | wo | @03 | o | PwMi | 1 |  SPLIN ] .

104 1o GPIO4 | UART RXD | 1O 12C2 CLK 0 PWMO
105 | wo | erios | o | uaRTTXD | 1o | 12c2 DAT ) PWM1
106 o | GPIOG ) UART RTS | 1O 12C2_CLK I | PDM_DATA
o7 | WO | GPIG7 | | | UART.CTS | WO | 12C2 DAT 0 | PDM_GLK
108 | wo | @Piog8 | © | UART.TXD | WO | SPLCLK I PDM. DATA
109 [ wo | eros | 1 | swok | 1 | sPN ) XO16132M
1010 1w | GPID1D | SWDIO o SPIOUT o CLK_32K
1011 w | PO | UART RXD | IO SPI_CS1 o CLK_32K

1G12 aD GPI12 = - l{e] 12C1_CLK - -
’I 1G13 QD GPI 13- | UART_CTS l{e] 12C1_DAT - -

life.augmented 1014 1o GPIO 14 o 12C1_CLK t{e] SPI_CLK - -



Quick Recap



DK 3.0.0 SW Architecture

SensorDemo

s ™
LEstack ) owsis

Library )

.

p
BlueNRG-2_Peripheral_Driver Board Support Package

. Drivers J

~

/
BlueNRG-2
)
)

. HW Components

p
STEVAL-BCNOO2V1

Lys
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STEVAL-BCNO002V1B

LSM6DSO
accelerometer + gyroscope

Block Dlag ram mes

Integrated

antenna

Matching
Network’

BALF-NRG-02D3

Integrated balun

TES

LIS2MDL
magnetometer

IRQ

LPS22HH
barometer

HTS221
Relative Humidity & Temp.

VL53L1
time-of-flight proximity

400
kHz

connector
Vv

7
=
o

N

RX line user button

=

RGB LED |

MP34DTO05-A

microphone




Sate | Aug powercons .
T Power Consumption

advertise 250ms 170uA
Battery notification 0.25mA
Environmental / AccEvents / LED control 0.3mA
Motion FX (Inertial) 1.4mA
BlueVoice 3.6mA
Motion FX plus Time Of Flight 8mA
BCN002V1 3V
60 [— ol I I | I I [ —
o Q. istantaneous
3 connected 3
9] )
50 — 9._ g —
o 5
> g
40 — §" _|
g 30 — —
5]
3 20 environm. HEXTOF Accevent LED ctrl BlueVoice battery | -
0.3mA ‘ “T i“ IW |“ 0.3mA  03mA | 36mA  0.25mA
|
. Kl N _
0 g et —
advertise motionFX advertise stand-by
"I 170UA | 1.4mA | | | | . 170uA | . 25UA
10 20 30 40 50 60 70 80 90 100

life.augmented
time [s]



Battery Lifetime: CR2032

_ Avg Power Cons | Battery lifetime

stand-by 25uA 8800 hrs / 367 days
advertise 250ms 170uA 1294 hrs / 54 days
Battery notification 0.25mA 880 hrs / 37 days
Environmental / AccEvents / LED control 0.3mA 733 hrs / 30 days
Motion FX (Inertial) 1.4mA 157 hrs / 6.5 days
BlueVoice 3.6mA 61.1 hrs /2.5 days
Motion FX plus Time Of Flight 8mA 27.5 hrs

Lys
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The End: Q&A
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Virtual COM Driver Installation Win7



